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Copyright

Documentation

©2020 Allworx Corp, a Windstream company. All rights reserved. No part of this publication may be
reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic,
mechanical, photocopy, recording, or otherwise without the prior written permission of Allworx Corp.

Software

Software in this product is Copyright 2020 Allworx Corp, a Windstream company, or its vendors. All
rights are reserved. The software is protected by United States of America copyright laws and
international treaty provisions applicable worldwide. Under such laws, the licensee is entitled to use
the copy of the software incorporated with the instrument as intended in the operation of the product
in which it is embedded. The software may not be copied, decompiled, reverse-engineered,
disassembled, or otherwise reduced to human-perceivable form. This is not the sale of the software or
any copy of the software; all right, title, ownership of the software remains with Allworx or its vendors.

Warranty

This warranty shall not apply to any products to the extent the defect or non-conformance is due to (A)
accident, alteration, abuse, misuse, or repair not performed by Allworx, (B) storage other than
specified, (C) failure to comply with applicable environmental requirements for the products.

Environmental Conditions

Allworx servers and phones

Operating:

Temperature +5°10 40° C / +41° to +104° F

Relative Humidity 5 to 90% (non-condensing)

Storage:

Low Temperature Point -40° C / +40° and any convenient humidity

High Temperature Point +66° C / +150° 15% RH

High Relative Humidity Point +32° C / +90° 90% RH
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Trademarks

The following trademarks are owned by Allworx:

Allworx® Verge™ IP phone series Allworx® Interact™ Allworx® Connect™ servers
Allworx® 92xx™ IP phone series Allworx® Interact™ Professional Allworx® Connect™ 731 server
Allworx® Verge™ 9304 Allworx® Connect™ 536/530 server
Allworx® Verge™ 9308 Allworx® Connect™ 536 server
Allworx® Verge™ 9312 Allworx® Connect™ 530 server

Allworx® Interact™ Softphone
Allworx® Interact Sync™

Allworx® Verge™ 9318Ex Allworx® Connect™ 324/320 server
Allworx® View™ Allworx® Connect™ 324 server
Allworx® View™ ACD Allworx® Connect™ 320 server

Allworx® Reach™
Allworx® Reach Link™ Allworx® OfficeSafe™

Allworx® Migrate™

Allworx® PowerFlex™

The Bluetooth® word mark and logos are registered trademarks owned by the Bluetooth SIG, Inc. and
any use of such marks by Allworx Corp., a Windstream company, is under license. Other trademarks
and trade names are those of their respective owners.

Revision History

Revision Date Description

A 21-0CT-2020  Title modification and content update for release 5.1. Including access to Visual
Voicemail through the Messages tab (Section 6.7).
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Chapter 1  Introduction

Allworx Interact Release 5.1 User Guide

Allworx Interact™ provides Windows PC users with an intuitive, configurable user interface for
controlling an Allworx desk phone (located physically near the user’s PC) or an Interact Softphone
(running inside the user’s Windows PC). There are three Interact modes:

1. Interact is a free application available to any Allworx user. This basic application mode displays an
inbound caller's name and number in a discrete pop-up dialog box on the user's PC desktop.
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From within this PC dialog box the user can view and answer calls that are incoming to their
Allworx desktop phone. They can also choose to send the call directly to their Voicemail (Message
Center) or ignore it. However, calls must be placed using the Allworx phone dialpad.

2. Interact Professional is a per-user licensed application mode that provides an expanded full-
featured user interface and additional capabilities to the basic Interact.
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This expanded user interface window has multiple active panes for Current Calls, Parked Calls, Call
History, System and Personal Contacts, and a Dialpad. The Contacts pane provides information
that includes an Allworx user’s presence, availability, and favorite status. With Interact
Professional, users can simply click once to dial, transfer, park, or record calls.

866.ALLWORX (866.255.9679) or 585.421.3850 Page 1
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3. Interact Softphone is another per-user licensed application mode that allows the user's Windows
PC to function as a phone. Calls are managed using the same Interact Professional expanded user
interface window with the PC microphone and speakers, or a PC headset (preferred), for audio
hardware instead of an Allworx desk phone.

Allworx Interact Release 5.1 User Guide
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Where a traditional Allworx desk phone associates functions with physical buttons (PFKs), Interact
Softphone enables those features from the Allworx server and provides indications within the user
interface. For example, a Message pane is included in the expanded user interface to provide
Softphone users with an indication of new voice messages and access to the Message Center.

Note: An Interact Softphone license allows the user to switch between controlling a Softphone and
controlling an Allworx desk phone, based on the handsets assigned to the user by the Allworx server
administrator.

1.1 Who Should Read this Guide

This guide is for individual users and Allworx administrators who install, configure, and use Interact
application software.

1.1.1  Guide Organization

This guide is organized by the layout of the user interface and each chapter provides step-by-step
instructions for using the features provided within the specified area of the user interface. For a cross
referenced list of the most common call management tasks discussed throughout this document, see
“Task Table” on page 91.

Page 2 866.ALLWORX (866.255.9679) or 585.421.3850
www.allworx.com
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1.2  Equipment Requirements

The following table provides a list of the equipment requirements necessary to perform the
procedures described in this document.

Equipment

Requirements

PC

+ Running OS (with latest service pack)

+ Windows 7, 32- and 64-bit (SP1) »+ Windows 8/8.1, 32- and 64-bit - Windows 10, 32- and 64-bit
+ Windows Server 2012/2012R, 2016, and 2019

* RAM minimum: 2 GB

+ Monitor resolution: 1024 x 768 (XGA)

+ Internet connection

« Allworx Interact application with Interact Professional, Interact Softphone, Interact Sync, if needed
+ Microsoft .NET Framework 4.5.1

+ Administrative permission for the PC for application installation

+ For Interact Softphone: Audio hardware suitable for business telephony; Allworx suggests

headsets certified by Microsoft (https://docs.microsoft.com/en-us/skypeforbusiness/
certification/devices-usb-devices)

Allworx Server

+ Allworx username and password
« Allworx System Software Version 8.6 (minimum required for Interact Softphone), 7.5.9.4 (minimum

for basic Interact and Interact Professional), but 7.5.19.1 or higher is preferred.

Notes:

+ Not all Interact Professional features will work with Allworx System Software 7.7 and lower.

« Allworx System Software version 8.5 and higher requires using Interact Professional version 4.0
or higher.

+ IP Address or DNS name of each Allworx server

+ Administration permissions and passwords for each Allworx server

+ Feature key for Interact Professional or Interact Softphone

« Feature key for Interact Sync (for Allworx System software 8.1 and lower)

+ Feature key for Automatic Call Distribution

+ Visibility to the Allworx View Server (also requires the View CDR function key - minimum)

Allworx IP Phones

(For Interact and
Interact
Professional only)

+ 92xx IP Phones
+ Verge IP phone series

866.ALLWORX (866.255.9679) or 585.421.3850 Page 3
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1.3  Product Comparison

Note: Interact with support for Interact Softphone can only be used with Allworx Connect Servers
running System Software version 8.6 or higher.

Allworx Interact
Basic Interact Professional and
Interact Softphone
(using pop-up dialog
box only) (using expanded
Interact Professional
user interface)

Call Handling
Answer / Ignore / End / Place on hold v v
Transfer / Park / Conference v

Interact Features

Access to the Allworx system directory, call history, and contacts v
Access to Microsoft® Outlook® application v
Access to application settings Limited v
Access to handset call history v

The following features require Allworx System Software 7.7 or higher.

Access to call queue status’ v
Access to call queue agent status (call supervisors only)1 v
Wipe current device v v
Change Allworx Password v v
Intercom call v
Page 4 866.ALLWORX (866.255.9679) or 585.421.3850
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Allworx Interact
Basic Interact Professional and
Interact Softphone
(using pop-up dialog
box only) (using expanded
Interact Professional
user interface)
Call queue features’ v
The following features require Allworx System Software 8.0.7.6 or higher.
Change Allworx PIN v v
Record All v
Access to agent login features' v
Launch the Allworx View application2 v
The following features require Allworx System Software 8.0.8.6 or higher.
Interact Sync® v
The following features require Allworx System Software 8.1 or higher.
Five- and six-digit extension dialing v
The following features require Allworx System Software 8.2 or higher.
Contacts 4 © v
Bluetooth Support® o
Call Handoff° v
Answer an ACD call regardless of ACD Queue logged in Status' v
Customizable keyboard shortcuts v
Receive a notification when an Allworx User extension is v
available
866.ALLWORX (866.255.9679) or 585.421.3850 Page 5
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Allworx Interact
Basic Interact Professional and
Interact Softphone
(using pop-up dialog
box only) (using expanded
Interact Professional
user interface)

Hide Interact Professional / Interact Softphone application in the v
Windows System Tray

The following features require Allworx System Software 8.5 or higher.

7

Park to Extension v
Conference calls v
The following features require Allworx System Software 8.6 or

higher.

Interact Softphone v
Messages tab for Interact Softphone access to Visual Voicemail v

T Requires the following:
+ Allworx Automatic Call Distribution feature key
+ User assigned as an agent to one or more call queues
+ Interact Professional handset with an ACD PFK assigned or the ACD Appearance or Queue Appearance
programmable function(s) assigned to an Interact Softphone handset

2 Requires the following:
+ Allworx View CDR feature key
+ Connection between the Allworx server and the View server.

3 Requires the following:
- Interact Sync feature key (one feature key enables the feature for all Allworx users)
+ Microsoft Skype for Business 2015 or 2016 installed
+ Microsoft Outlook 2010, 2013, or 2016 installed
- Google Chrome™ version 41.0.2272 (minimum)

- Mozilla Firefox® Version 38.0 (minimum)

4 Personal Contact management requires an Allworx Connect series server.
5 Requires the Verge 9312 IP Phone for Interact Professional.

6 External Personal Contacts are not synchronized with the Verge 9304 IP Phone.

7 Compatible with Interact application version 4.0 or later — including Interact 5.0 with support for Interact Softphone.

Page 6 866.ALLWORX (866.255.9679) or 585.421.3850
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Chapter 2 Installation

This chapter describes how to install the Interact application and then how to log in to Interact
Professional and Interact Softphone.

A single Interact installation file provides the needed options for installing all Interact modes
(including Softphone) and Interact Sync. Both Interact Sync and Softphone are selections that can be
made during the installation. For information about the available Interact modes, see “Introduction” on

page 1.

To enable Interact Professional, the Allworx Server Administrator needs to provision an Allworx
Interact Professional license for each user. When the user logs in after that license becomes available,
they automatically have the Interact Professional version of the application. If no license is available,
they see the basic Interact version of the application.

The Interact Softphone software is delivered with Interact software, and users with an Interact
Softphone license can use their PC as a phone — with the expanded Interact user interface and the PC
microphone and speaker for audio hardware (instead of Allworx desk phone hardware). An Interact
Softphone license also allows the user to switch between controlling a Softphone and controlling an
Allworx desk phone.

Notes:

« The basic Interact application is automatically available to users without the need to purchase
licenses.

 If a user has an Interact Softphone license assigned, they do not also require an Interact
Professional license.

2.1 Checklist

Complete the following steps in this order for a successful installation. Click the links in the More
Information column for additional details.

Step Description More Information

Download and Install the Interact Application
Note:
« You must have administrator rights for the PC on which the application will be installed.

« Allworx Connect server needs a Feature Key for the number of Interact Professional and/or Interact Softphone handsets
needed, and these Feature Keys must be installed prior to installing and logging in to those applications.

1 Allworx Connect server must be running the appropriate version See “Equipment Requirements” on page 3
of the Allworx System Software.

2 The Allworx server administrator may create Handset See the Allworx System Software
Configuration Templates for some classes of users (e.g. add  Administrator Guide.
the ACD function to a template for Softphone ACD users).

866.ALLWORX (866.255.9679) or 585.421.3850 Page 7
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Step Description More Information
3 The Allworx server administrator completes one of the See the Allworx System Software
following tasks: Administrator Guide.

« Create the required handsets, assign them to users, and
adjust the handset configuration for each handset.

« Make some Interact Softphone users eligible to create the
required handsets and configure the Handset Configuration
Template to be used for those handsets.

Note: Users who have been assigned an Interact Softphone
handset, or are eligible to create their own, will find that option in
the Handset Selection dialog box when logging into Interact. The
description for an Interact Softphone handset always includes
the PC hostname of the last place that handset was used.

4 Download the Interact application from the following location:  See “To install the application:” on page 9.

http://get.allworx.com/interact/

5 Double-click the downloaded installer to start the installation
wizard.

6 Click Next.

7 Accept the End-User License Agreement and click Next.

8 Click to select to install Interact Softphone or leave the
selection blank to not install Softphone.

9 Click Next.

10 Configure the application shortcut by checking the box and
click Next.

11 The Ready to Install dialog box opens. Click Install to begin.
Follow the instructions in the setup wizard.

12 Click Finish to complete the installation and launch the
application.

Log in to the Interact Application

9 Launch the Interact application See “To log in to the application:” on
10 Enter the Allworx Username and Password. page 10.
11 Enter the Allworx Server IP address.

12 Click Login.

2.1.1 Interact Application Licensing

With an Interact Professional license, each user with a license can run the software simultaneously on
as many PCs as needed. The description on the license changes to reflect the name of the most
recent PC on which it was started.

This description also applies to an Interact Softphone license when using the Interact Professional
features to control Allworx desk phones. However, when using the Softphone inside the Windows PC,

Page 8 866.ALLWORX (866.255.9679) or 585.421.3850
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the license can be used for multiple locations but not simultaneously. One license equals one handset
(including its configuration), and that license can migrate from one PC to another (e.g. desk phone by
day and Softphone in a laptop at night). For multiple locations and simultaneous uses of Softphone,
multiple Interact Softphone licenses are required. The Allworx server administrator must create
multiple Interact Softphone handsets, each with their own configuration.

Allworx Interact Release 5.1 User Guide

2.2 Installing and Logging In to the Application

Note: The Interact application supports Terminal Services/Remote Desktop Services on Windows
Server 2008, Windows Server 2008 R2, Windows Server 2012, and Windows Server 2012 R2 using the
Enterprise installer. The Enterprise installer also supports deployment through Group Policy Objects.

To install the application:

1. Navigate to http://get.allworx.com/interact/ to locate and download the appropriate application
installer file.

Double-click the downloaded installer. The Interact Setup Wizard dialog box opens.
Click Next.

Accept the End-User License Agreement and click Next.

a > 0N

Select an Interact Sync setup option.

Option Description

Do not install Interact Sync. I will Bypasses the Interact Sync installation step. This is the default setting.
install it later if | need it.

Install Interact Sync now Installs Interact Sync.
(Administrator

. Installing this feature requires:
access required.).

« Interact Sync feature key (one feature key enables the feature for all
Allworx users)
« At least one of the following:
* Microsoft Skype for Business 2015 or 2016 installed
* Microsoft Outlook 2010, 2013, or 2016 installed
* Google Chrome
* Mozilla Firefox

6. Click to select to install Interact Softphone, or leave the selection blank to not install Softphone.

7. Click Next. Configure the application shortcut by checking the box.

Option Description

Create a shortcut for Interact on the desktop Places a start up icon on the computer desktop. User double-
clicks to activate application.

Start Interact automatically when | log in Log in to the computer, and Interact automatically initiates.

866.ALLWORX (866.255.9679) or 585.421.3850 Page 9
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8. Click Next. The Ready to Install dialog box opens. Click Install to begin.
9. Click Yes in the User Account Control window, if prompted.
10.Click the Launch Interact check box.

11.Click Finish to complete the installation and launch the application.

To log in to the application:
1. Launch the Interact application.

2. Enter the Allworx Username and Allworx Password in the dialog box.

3. Enter the Allworx Server IP address. If the IP address is unknown, click Find Server IP.
Notes:
+ If needed, ask the Network/System Administrator responsible for client PCs on the network the IP
address of the server, and enter the IP address manually.

« Ask the Allworx administrator to add a firewall exception on the workstation for the Interact
application.

+ On first use of Interact Softphone, the user should click on the Audio Device Selection icon and
select appropriate devices for Microphone and Speaker. This selection can also be made by
selecting Audio Devices from the settings icon (%) drop-down list.

4. Click Login.

Application Mode Behavior

Interact The application icon is visible in the Windows System Tray.

Interact Professional and  The application opens and displays the full-featured user interface, and the application
Interact Softphone icon is visible in the Windows System Tray which is by default in the lower, right corner
of the PC screen.

Note: If the application was closed while hidden, the application re-opens hidden
(minimized to the Windows System Tray).

After clicking Login, one or more of the following notifications may appear:

Notification Description

Handset Selection Displays if the user has multiple assigned handsets.

* Click to select a handset from the drop-down list.
+ Click Create a Softphone handset if available. This option is only available if the
Allworx Administrator has made the user eligible.

* Click OK to continue logging in to the application.

Install Interact Sync Displays when the Interact Sync option is not installed and informs users of the
additional benefits of installing Interact Sync to use with Interact Professional and
Interact Softphone.

Select an available option; the recommended option is Install Interact Sync now
(Administrator access required).
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Notification Description

Update is available Displays when there is an Interact application upgrade available.

Click Yes to update the application or click No to continue logging in to the application.

Change password Displays if the Allworx administrator requires the user to change the current Allworx
password. Follow the prompts to change the current password. See “Changing the
Allworx Password or Allworx PIN” on page 11.

Set your user image Displays when the user who is logged in to the application does not have a contact
image.

Click Yes to update the contact image or click No to continue.

Sync contacts with Displays the first time the Interact Professional or Interact Softphone user logs in to
Outlook synchronize Outlook contacts with Personal Contacts.

New Outlook contacts Displays when the Interact application has found new Personal Contacts in the Outlook
found application.

Note: This is only available on Verge IP phones using a Connect server.

5. Download the supporting documentation from http://get.allworx.com/interact.

6. Place atest phone call. See “Managing Calls” on page 21 for more information.

2.3 Changing the Allworx Password or Allworx PIN

Initiate a change to the user login password (for application login) or PIN (for access to ACD queues,

Allworx Message Center, etc) from the settings ( £ ) drop-down list. To make the change, users must
supply both old and new passwords or PINs during the request in the dialog box. The new password or
PIN must comply with the Allworx System Software requirements.

To change the login password or PIN:
1. Log in to the application, and then follow the steps for one of these options:

Option Interact Basic R UL
P Professional | Softphone
Interact Icon in the Windows System Tray or on the Interact v v v

application Settings icon > Settings and select: Change
Password or Change PIN

From the settings menu ( % ) navigate to Options > v v
Change Password or Change PIN.

2. Enter the required information in the pop-up dialog box
Click OK.

A notification displays indicating the request was successful. Click OK in that pop-up window to
return to the application.

866.ALLWORX (866.255.9679) or 585.421.3850 Page 11
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2.4 Connecting Headsets

Both the Interact and Interact Professional applications connect to an Allworx Verge phone and the
headsets are connected to those phones as indicated in the user guides for the Allworx 92xx and
Verge series IP phones. These documents are available on the Allworx website Partner Portal
(allworxportal.com).

Interact Softphone allows users to place and receive calls using their Windows PC - without
connection to an Allworx phone. As a consequence, wired (preferably USB) and Bluetooth headsets
are connected to the PC itself as directed in that equipment’s documentation.

Note: For information about recommended headsets, see the document titled “Allworx Headset
Compatibility Guide” that is available at allworxportal.com.
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Chapter 3  Application User Interface Overview

There are two user interfaces for managing calls in the Allworx Interact application modes. The first is
a pop-up dialog box that is available for all three applications modes and appears in the lower right
corner of the PC desktop when there is an incoming call. Basic Interact connects to an Allworx desk

phone and this dialog box is the only way to answer a call, put a call on hold, or end a call on a PC
when using that mode.

Allwone Interact (%]
"
e Bill Jones
015
Answer | To Vi | lgnore
Open Interact [A <_Th|s Optlon.IS not available in the dialog
box for basic Interact.

For all Interact application modes, click one of the following actions in this dialog box:

Action Description

Answer Accepts the call.

To VM Transfer the call to Voicemail (Message Center).

Ignore Stops the ringing of the incoming call and dismisses the dialog pop-up.

Open Interact Opens the minimized Interact Professional / Interact Softphone expanded user interface.

(not available for
basic Interact)

The second user interface provides expanded call management features for both the Interact
Professional and Interact Softphone application modes.

An Interact Professional license, like basic Interact, connects the user’s PC to an Allworx desk phone
and has those same capabilities, but adds the abilities to place, transfer, park, or conference a call.
Additionally, Interact Professional provides access to Call History, Queue Status, as well as Allworx

System, User, and Personal Contacts. All features are accessed from the Interact Professional user
interface.

An Interact Softphone license allows the use of the expanded Interact user interface to run a phone
entirely within the Windows PC using the full-featured Interact Professional user interface. Depending
on the configuration defined by the Allworx server administrator, this license can also allow user’s to
manage calls through their Allworx desk phone.

For detailed information about implementing the Interact Professional user interface features, see
“User Interface Window” on page 51. This user interface uses visual cues for call status and User
Contact presence, availability, and favorite status.
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The following screen is an example of the expanded, full-featured user interface window used with
Interact Professional and Interact Softphone.

Volume Control / Softphone
Audio Device Selection

i Call Recordin
Do Not Disturb 9 Application Settings Menu
Station Appearances

Caller ID Name/Number
Presence Setting

Status v v \ 2N 4
Bar—Pp weercom v ] [ inofke % Wi onen 0| ¥
Sue Smitih .
# ACD Q Administraton System
40 1188 Sue Smitih
T Anorymeows Call Hardhe § Auites Attencant 1o
. o B _
Active n Bakse, Jay T Goteres g Unknown
. nH 1000 - h
Window B cooktous ) 5 ey way g U :
Action ) Oomestic. Sales | Door ey - .r\um.!\.r(ervja:l: Qamc | Hee
e a3 <
Area 1 o Mo h Flores, Set r .— 0 1 Gm | B
hrnds T B Auto Attendant
'E Graham. Courtney R Green, Kanen - a0 7 ean =8
T Ty 7 Hn w
B oo [ Hotine - North America g ik
- . ot | Bt
e e Ty - E——

Slide-to-
Hide Open
Windows

W Agont: Btiones

The main user interface window (page 14) provides the flexibility to customize the display and
position of the panes within the window to accommodate user preferences. Users can set the
preferences listed in the following table.

Note: For information about how to define the panes that are visible within the user interface window,
see “Adjusting Application Settings” on page 39.

Preference Description
Slide-to-hide tab Click to open the window. Click the Unpinned active icon to keep the window open. The
window is available to undock from the main application window.
Pin or Unpin Click the Pin active icon for each window to keep that window visible while docked in
one of the slide-to-hide panels.
Resize Open each window within the main application screen and manage the windows size
without using valuable computer screen space.
Continued
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Preference Description

Undock or dock Place the windows on top or under the main application menu window (maximized
applications can obscure the view).

Undocked windows Detaches the current window from the main application screen
for custom size and placement. All windows close when exiting
the Allworx Interact Professional or Interact Softphone
application mode and open in the same location when
relaunching the application.

To undock the window:
1. Pin open the windows prior to undocking the window, see above.

2. Double-click or click and drag the title bar of the application window.
3. Move and adjust the window.

Docked windows Returns the window back to the main application window.

To dock the window:

1. Double-click the window title bar or click and drag the window back
to the main application window.

2. Drag the window to one of the placement targets shown on the
application.

Shortcut: To return the undocked window to the original,
docked position, double-click the undocked window title bar or
window header.

<]

.1

Sample window
placement options

“OdmgpasEana

=EEE

X Makes the window invisible in the docked or undocked state.
To make the window visible, navigate go to the Settings menu.
See “Adjusting Application Settings” on page 39 for more
information.

3.1 System Tray

All of the Interact application modes display the icon in the Microsoft Windows system tray (by default
in the lower, right corner of the PC screen). Right-click the Interact icon to select one of the

configuration options. H
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The available options are:

Show Active Call window or Hide Active Call window* « Launch Allworx View**

+ Update (displays only when a software update is + Find out more
available)

« Options... + About

+ Change password + Logout <username>
Change PIN + Open

+ Reset Ul configuration* +  Exit

* Available only with Interact Professional and Interact Softphone licenses

** Available only with Interact Professional and Interact Softphone licenses and an Allworx
View license

Note: See “Adjusting Application Settings” on page 39 for detailed information about each option.

3.2 lcons

The expanded user interface uses icons to navigate through the Interact Professional and Interact
Softphone application modes, view the status of a call or user contact, and manage calls. The
presence status icons and availability status apply to User Contacts only.

The following sections show and describe the icons available in the expanded user interface.

3.2.1  Navigation Icons

Navigation icons direct the user to panes within the window or menus to access the features available
within the Interact application.

\ Active Calls pane O Agent: <name> pane
& \, "

\ Current Calls pane
fF Outside Lines pane E Parked Calls pane

Dialpad pane

0 Queue Status pane -l:l- Settings
+
& New Interact software is available.
|
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Status lcons
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The status icons provide a visual cue of contact type, presence status, and call status.

]

Contact image icon - red corner indicates an
Allworx contact.

Contact favorite.

Contact is not a favorite.

Presence Status - On Business Trip.

0

Presence Status - Busy.

Presence Status - At Home.

Presence Status - At A Meeting.

gkl .

Presence Status - Away.

Presence Status - On Vacation.

Presence Status - Unknown.

Call Status - Incoming call or call answered
elsewhere

Call Status - Outgoing phone call, no answer.

Call Status - Incoming, missed call.

Call Status - Outgoing phone call.

q:.:awl— 'ﬁﬂ

Application error icon, such as BLF lost,
Interact lost connection, running out of
recording space etc.

Note: When this icon appears next to the
Presence pull-down, it indicates a loss of BLF.
The icon may flash on and off to indicate an
intermittent loss. For more information, refer to

the Miscellaneous heading in “Troubleshooting”
on page 85.

NN

Notify when available activated for Allworx
User Contact.

L

Number of new messages available through
Visual Voicemail or the audio Message Center.
(Available for Interact Softphone only)

3.2.3

Action Icons

The action icons allow users to customize the user interface and use the application to manage calls.
Click the icon to activate the feature.

X

Closes pan within the application user
interface. Sets an undocked window to
invisible. See “Adjusting Application Settings”
on page 39 to reactivate window.

Note: If the application was closed while
hidden, the application re-opens hidden
(minimized to the Windows System Tray).

0

Pinned pane - the pane is available for
undocking.

=

Unpinned pane. The pane is available for the
Slide-to-Hide option.

Do Not Disturb is Inactive.

Continued
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Do Not Disturb is Active. Mute is Inactive.

Mute is Active. + Opens Volume Control to set the loudness of

ringtones and speaker phone on an Allworx
desk phone for Interact Professional.

OR

+ Opens the Audio Device Settings dialog box
to select the audio device(s) for the
microphone, speaker, and ringtone for
Interact Softphone using PC audio hardware
or other handset, as well as adjust volumes.

Note: The Volume Control ion is not available
when using Interact Professional with a 92xx
series Allworx Phone.

Pause Call Recording. Resume Recording.

End Call Recording. Begin Call Recording.

Search - Call History and Contacts panes. More Options - Call History and Contacts

panes.

Add Contact - Contacts pane. Single Column Display - Contacts pane.

Multiple Column Display - Contacts pane. Name/Favorite Status Display - Contacts pane.

Backspace - Dialpad pane.

<]y 0N - (e mii=
L < flollv

| | Place a phone call from the Dialpad pane.

Note: Click twice to redial the last number.

3.3  Wipe Current Device

The Wipe remote devices option in the Allworx System Administration web page allows the Allworx
server administrator to remove all login credentials and voicemail information for a lost or stolen
remote device. Additionally, this feature disables the device from sending and receiving phone calls.
This option requires the Allworx server administrator to change the user password. Information about
this procedure is available in the Allworx System Software Administrator Guide that is available on the
Partner Portal (https://allworxportal.com/)

To use the Interact application after receiving a wipe command, log in using the current credentials
and the new password provided by the Allworx server administrator. See “To log in to the application:”
on page 10 for more information.
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3.4 Interact Sync

Interact Sync is a customizable plug-in for Interact that allows click-to-dial capabilities between the
expanded user interface and versions of Skype for Business 2015 or 2016, Microsoft Outlook
applications, and the Google Chrome and Mozilla Firefox web browsers installed on the PC.
Additionally, Interact Sync supports synchronization between the Allworx Interact Presence and the
availability setting in Skype for Business, Microsoft Outlook, and the Allworx phone.

Allworx Interact Release 5.1 User Guide

For more information, see “Interact Sync” on page 79.

866.ALLWORX (866.255.9679) or 585.421.3850 Page 19
www.allworx.com
Version: A Revised: October 21, 2020



G allworx

Allworx Interact Release 5.1 User Guide

Page 20 866.ALLWORX (866.255.9679) or 585.421.3850
www.allworx.com
Version: A Revised: October 21, 2020



eallv@.,
Chapter4 Managing Calls

Allworx Interact Release 5.1 User Guide

Use the Interact application modes to manage incoming and outgoing phone calls using a PC. Basic
Interact and Interact Professional manage calls through Allworx phones, while Interact Softphone is
able to place and receive calls directly from a Windows PC without a connection to an Allworx desk
phone. The following common call management features are discussed in this chapter. Features not
available within the basic Interact dialog box are available through the Allworx desk phone.

Interact Professional
Basic Interact and Interact Softphone
Feature (using pop-up dialog box | (using expanded Interact
only) Professional user
interface)
Pl Il
ace aca v v
A Il
nswer a ca v v
Pl Il on hold
ace a call on ho v v
E Il
nd aca v v
Answer a call in a queue v
T f Il
ransrer a ca v
Int Il
ntercom ca v
Conf Il
onterence ca v
Park Il
ark aca v
S i Il
upervise a ca v
E Alert
mergency Alerts v

Note: A full list of Interact features and where information about those features can be found in this
document is included in Appendix A “Task Table” on page 91.
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To avoid disconnecting a call when answering a second incoming call, it is recommended that your
Allworx System Administrator configure your phone’s Handset Preference Group to enable Auto On
Hold, or you can configure your Allworx desk phone as indicated in the following table.

Phone Phone Navigation

92xx IP Phones CONFIG > Preferences > Auto On Hold. Select Enabled and exit the menu. When
prompted to Save to Flash, press the Yes soft key.

Verge IP phone series Settings > Phone Preferences > Call Handling > Auto On Hold. Select Enabled. Press
Back to return to the Settings screen and Back again to return to the Idle screen.

4.1 Placing a Call

Use one of the following options to place a call from the user interface:

Interact Professional

Option Basic Interact Expanded User Interface Interact Softphone
p (using pop-up dialog box)  (through an Allworx desk Expanded User Interface
phone)
Allworx Desk Phone v v

Note: With basic Interact, calls
can only be placed using the
Allworx desk phone. Calls
cannot be placed using the
pop-up dialog box.

Call Hist
all History pane P P
Contacts pane
v v
Dialpad
ialpad pane P P

To place a call using an Allworx desk phone:

Pick up the handset or press the speaker phone soft key, and then dial a number. After dialing the call,

the Interact application displays the pop-up dialog box with the Cancel button. Press the Cancel button
to stop placing the call.

To place a call using the expanded user interface Call History or Contacts pane:
1. Locate a listing in the appropriate pane of the user interface.

2. Select that listing by double-clicking it or by right-clicking and selecting Dial or Intercom from the
drop-down list.
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3. If the Allworx User Contact is busy, right-click that listing in the Contacts pane and select Notify
when available from the drop-down list. When the Allworx user’s extension becomes available, the
user interface displays a pop-up notification message.

Allworx User Contact is Busy Notify when available Active Pop-up notification

& Contacts = o x F eque:le ser

. o
ey i B oo Lovisy
K] | a|
'___\ :Jc‘m']s I’a‘fibi:flserva[ions. Don's _\ Dcm; s flsl.‘r\-'at!olﬁ. Don's

To place a call using the expanded user interface Dialpad pane:
See “Dialpad” on page 69 for more information.

To place a call using Skype for Business:
Open the Skype for Business application and take one of the following actions:

1. Right-click a main contact listing to display the context menu and click to select Allworx Dial from
the menu.

Send an IM

Call ]

Start a Video Call -

Send an Email Message

Find Previouz Conversations

= O
Add to Favorites 2
- ﬂ.
Copy Contact To (1
Find someons IMove Contact To k Q
EROUBS STATUS Remove from Group 2+

Remove from Contacts List
4 FEVORITES

Tag for Status Change Al

4 OTHER CONTACTS [1
= Change Privacy Relationship b

See Contact Card

Christina.Va

4 COWORKERS {1)
Courtney Graham - &vallable
& InCifice

Elana Hayes - avaitable
& InDfce

David Quill - svaslable
@ nofes
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2. Click the “..." menu on a conversion window and click to select Allworx Dial in the pop-up menu.

Allworx Interact Release 5.1 User Guide

L] asccadPadea ® -0 x

Christina.VanDyne@epi.com @
Presence in Offce

Ianage Recordings
IM Jext Display Sae »
Change Font...

Adtwors Dial,

Skype for Business Help

3. Click the participant list, then right-click the user and click to select Allworx Dial from the pop-up
list.

@ - o0 x

John Allen@epi.com

John.Allen@epi.com

e 2 Participants |

Tom.Wilson@epi.com

PARTICIPANTS ®

John A ® ! m« B
Remove from Meeting

O Tom W 9 | L]

[£5 See Contact Card

»l Allwork Dial...
Invite More People
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4.2 Answering a Call

The following notifications display on the PC screen when there is an incoming call:

Allworx Interact Release 5.1 User Guide

Allworx Interact
Professional and Interact
Softphone
(using expanded Interact
Professional user interface)

Basic Interact
Notification (using pop-up dialog box)

Pop-up dialog b
op-up dialog box v v

Current Calls pane opens v

To answer a call from the pop-up dialog box:

For incoming calls, a pop-up dialog box displays the caller ID name/number and call management
options. Click one of the following options:

Option  Description

Answer Accept the call.

Ignore Silences ringing and dismisses the dialog for that call. This is the same as pressing the Allworx
phone Silent soft key.

To answer a call in the expanded user interface Current Calls pane:
For incoming calls, the Current Calls pane displays call information and call management options.

Pane Feature Description

State of the Current Calls Pane

Unpinned The Winqow opens (auto pins), and then automatically closes the window when the call ends.
Pinned The window does not close when the call ends.
-Displayed Information

Incoming call listing Status icon/call aetans.
+ Caller ID name and number.

Call Notification Pop-up indicating an incoming call with the caller ID name and number.
mptions

Answer Bisplays the call In the Current Calls window and accepts the call.

Ignore Displays in the Current Calls window and silences ringing. Click Answer to retrieve the call. This

behavior is the same as pressing the Allworx phone Silent soft key.
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To answer another user’s call from the expanded user interface Contacts pane:
The contact listing flashes red when there is an incoming call.

1. Right-click the Contacts pane listing.

2. Click to select Answer from the drop-down list.

4.2.1 Answering a Call in a Queue

To be able to answer incoming calls to ACD or Ring All queues, the Allworx Server Administrator adds
Programmable Function Keys (PFKs) to Allworx desk phones, or Programmable Functions to Interact
Softphone.

Note: The appropriate Feature Keys must be installed on the server prior to defining these queue
functions.

All calls, including calls to ACD and Ring All queues, appear in the Current Calls pane and can be
answered from there. ACD queue agents have the additional option of answering the call from the
Agent <name> tab located in the bottom left of the Interact expanded user interface window.

i A Call Handl Unk
# 19nggm).rmm.ls. all Handler ; 41r11 nown . ]
'3 Auto Attendant . 1
== 400 = Auto Attendant
" . == 400 ]
Bailey, Charles 4
1oz {85 Auto Attendant
m Baker, Jay ==l 400 |
N 1131 7
v . 1 Ring All
# soaofoeterla # 2401 T
i 4 Conference Center Unknown
2 e § Sy o ]
'e Cook, Louis — .. il -
1058 . I . L
Ci Agent: Billones +O Queue Status | N Active System Calls
For more information, see “Agent: <name>" on page 52.
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4.3

Placing a Call On Hold

Allworx Interact Release 5.1 User Guide

The Hold feature allows the temporary interruption of the connection between the callers without

disconnecting the call.

To place a call on hold:

Follow the steps included in the following table.

Hold Feature

Basic Interact
(using pop-up dialog box)

Allworx Interact Professional and
Interact Softphone
(using expanded Interact Professional
user interface)

Privacy Hold

Click Hold in the Interact pop-up dialog box
(default is the lower, right-hand corner of
the computer screen).

Click Hold in Current Calls pane of the user
interface. The call listing displays the
following information:

« status icon/call status

+ call duration

« caller ID name and number

« End Call and Resume buttons

Shared Call Appearance
Privacy Hold or
Shared Hold

Click Hold from the drop-down list in the
Interact pop-up dialog box to select the
preferred option. The default behavior is
Shared Hold.

Click the Hold drop-down menu in the
Current Calls pane of the user interface to
select the preferred option. The default
behavior is Shared Hold.

Resume a held call

Click Resume in the Interact pop-up
window.

Click Resume in the Current Calls pane.

Disconnect the current call

Click End Call in the Interact pop-up
window.

Click End Call in the Current Calls pane.

4.4 Parking a Call

The expanded user interface provides access to the System Park and Park to Extension features for
both Interact Professional and Interact Softphone. For more information see “To park a call:" on

page 66.
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4.5 Supervising a Call

The ability of a user to supervise calls is defined by the Allworx system administrator when the user is
created (Handset Preference Group) and when the PFK (Allworx desk phone) or Programmable
Function (Interact Softphone) is assigned to the handset (see the Allworx System Software
Administrator Guide for information).

To supervise the call use the PFK on the Allworx desk phone for Interact Professional.

For Interact Softphone, click to open the call appearance drop-down menu and select the appropriate
mode of call supervision.

Sue Smtih - BOSPCO1A - #5.. W

(@) Sue Smitih - BOGPCO1A - #5106

Select one of the following options:

Supervise (Whisper) - This selection allows the supervisor
to speak to the user without the caller hearing the conversa-
tion.

[ Shared Call Appearance
) Intercom

: : | Supervise (Monitor) - The supervisor cannot speak with
(_) Supervise (Whisper) either party on the call.

(1 Supervise (Monitor) ' Supervise (Barge) - The supervisor can fully participate in
the call with both parities.

(1 Supervise (Barge)

=00 Note: This user has three Call Supervision Programmable
Functions assigned to the handset - one for each Supervise
mode.

Or, right-click on the Contact or Call History pane listing and select the supervise mode from the drop-
down list.

O T T

[T
-
Bailey, Charles =
1021 [ _ ]
| || Favorite | -
i ! | ==
# Cafel ] parked call notifications -
1000 | f
- { Dial [
e CR. L 5
1004 | [ntercom i_ ! | #
'ﬂ DDDI‘E SHperve >H ! Ba,r.ge_ *_
8 403 | Details... f :
L4 ":_ FIDTEE_ . L A avdliaiie |,
P 1149 ,.
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4.6 Ending a Call

Click End Call in one of the following locations:

Allworx Interact
Professional and Interact
Softphone
(using expanded Interact
Professional user interface)

Basic Interact
Location (using pop-up dialog box)

Pop-up dialog box

Current Calls pane

4.7 Placing an Intercom Call

The Intercom feature displays in the expanded user interface for Interact Softphone at all times, and
for Interact Professional only if the Allworx desk phone supports the feature.

+ If that call appearance is currently in use, the Interact Professional application hides the option on
the right-click drop-down list.

« If all other default call appearances are unavailable the application uses the Intercom appearance.

To place an Intercom call (option 1):

1. Open the Call History or Contacts pane and right-click the appropriate listing. Select Intercom from
the drop-down list.

g Bailey, Charles
TR 1021 [ ] Favorite
PN Cafetes || Parked call notifications
Ilil ann
1o Dial
!.E:"": CR, Lib Intercom
N 1004 :
Supervise >
& |
gl CoorR i
i 403 Details...
"o
E- Flores, scox

2. Wait for the tone accompanied by a single ring. The Allworx desk phone or Softphone on the
receiving end automatically answers the call (default). Begin speaking when the call is answered.

Note: Intercom calls to external phone numbers ring as a normal call.
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To place an Intercom call (option 2):

1. Locate the station appearance and click the drop-down arrow for the default line. Click to select
Intercom from the drop-down list.

nje

]

Sue Smtih - BOGPCO1A - #5... b
(w1 Sue Smtih - BOGPCO1A - #5103
i1 Intercom

2. Double-click a listing in the Contacts or Call History pane or use the Dialpad. Begin speaking when
the call is answered.

4.8 Receiving Emergency Alerts

Allworx System Software provides the Allworx System Administration web page for access to settings
that allow users to receive Emergency Alerts on the Verge phones and on the expanded Interact user
interface window when using Interact Softphone. For more information on these server settings, see
the Allworx System Software Administrator Guide available on https://allworxportal.com/.

In order to receive Emergency Alerts for Interact Professional, a Programmable Function Key (PFK)
must be created on the Allworx desk phone. For more information, see the appropriate phone user
guide available on the Allworx portal. No Emergency Alert message is displayed on the expanded user
interface window for Interact Professional - only the Allworx phone indicators are available.

To receive Emergency Alerts when using the Interact Softphone application mode, the Handset
Emergency Alert Programmable Function must be added for the handset. When a call is made to the
emergency number defined in the handset Dial Plan a flashing pop-up window appears on the
expanded Interact user interface.
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In addition to the pop-up window, an audible alarm sounds for the duration defined by the Allworx
server administrator in the Interact Softphone Programmable Function.

[ s FOIT _Tnhn T Hnfling - Marfh Amaricy |
Emergency Alerts *

Dialed By: Bill Jones
Dialed On: Wednesday, May 13, 2020 11:30 AM e

Call-back Number: 5104

| | Silent || Dismiss |
| mwww Faging £One | mmew Faging fone

+ Click Silent to stop the audible alarm but continue to display the pop-up window.
+ Click Dismiss to silence the audible alarm and stop the display of the current alert.

+ Click X to close the pop-up window.
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Chapter 5 Status Bar Features
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Note: The information in this chapter applies only to the Interact Professional expanded user interface
used to manage calls through an Allworx desk phone or Interact Softphone. These features are not
available with basic Interact.

The status bar appears at the top of the expanded user interface window and provides access to the
following features:

+ Do Not Disturb (DND)

+  Mute

+ Volume levels / Softphone Audio Device Selection
« Call recording

+ Phone line access through station appearances
+ User presence settings

Caller ID name and extension

+ Application settings

Volume Control / Softphone
Audio Device Selection

Station Appearance Caller ID Name and Number

DND Call Recording . Settings
Presence Settings
Mute i ¢ ¢
+ Jane Smith ' v 0 Avay : § sane smith 214 T
‘ E m & c “ B i - Jane Seith GH u‘
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5.1 Using DND (Do Not Disturb)

When activated, the DND feature stops the handset (Allworx desk phone or Interact Softphone)

connected to the application from ringing. Users can continue to place calls from the application user
interface or the Allworx desk phone.

Action Description

To activate DND Click the DND button ([§)).
« All calls follow the next step in the active call route.

* Itis possible to activate the DND option during an active call. Doing so activates the
feature for subsequent incoming calls.

To deactivate DND Click the DND button () a second time.

5.2 Muting a Call

When invoking the Mute feature on an active call, the individual at the other end of the call can no
longer hear the user.

Action Description
To activate mute Click the mute icon (EY).
To deactivate mute Click the mute icon (77) a second time.

5.3 Adjusting Volume Levels and Selecting Audio Devices

Click the speaker icon (EH) to adjust the volume levels for the handset, speaker, headset, Bluetooth,
ringer, and paging by sliding the adjustment bar to the left (quieter) or right (louder). The Bluetooth and

headset options are available only when that device is connected to the Allworx desk phone or to the
PC for Interact Softphone.

Allworx Desk Phone Volume Control Interact Softphone Audio Device Settings

Audio device selection B Volume controls -
shone: | Flanbronics Blackwre 3210 Senes |Hesdset Microphone)
Choesing & Microphens devics will suomaticaly select the sare davics
far Speaker and Ringione. f pozsibls
Speaker -5
Spedke | Plantronica Blackwire 3210 Series (Headse! Earphone)
Headset 1
e -
I the ¥ o Con A e Plavnack Pro o
1 T = device, = hangs B Leys
Ha | High Defintlion Audic Device | Speakers)
Ringer -2
Play ringtons through Ringtons and Speaker routes
Pag|ng D Hrngone Vaolume
100
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5.3.1 Selecting an Interact Softphone Audio Device

Interact Softphone allows the user’s Windows PC to function as a phone. With that capability, the user
can use the existing PC audio devices, or they can add headsets, microphones, and speakers that are
compatible with their PC and attached through USB (recommended) or Bluetooth.

To select an audio device or ringtone:

1. Click the speaker icon in the Status Bar ().

2. Click the drop-down arrow to select the appropriate Microphone, Speaker, or Ringtone.
3. Click Test to try out the selection.

4. Click Stop to end the test.

Microphone: | Plantranics Blackwire 3210 Series (Headset Microphone) | Stop

Choosing a Microphaone device will automatically select the same device -
for Speaker and Ringtone, if possible.

5.4 Recording a Call

The call recording feature allows users to start, pause, resume, and stop the recording of the current,
active call (including conference calls). During the active call the user interface provides a status
indicator by showing a red dot in the Current Calls pane listing.

Current Calls (1)

F & Active
e Rill Jones 0006

015

Epd Call Hold Maore W

Call Recording Indicator

The Allworx administrator must enable the Call Recording feature for the user. Programmable
Function Keys (PFK) can be defined on the Allworx desk phone for Interact Professional. Interact
Softphone has call recording enabled by default without defining it as a programmable function.

Allworx desk phones support the call recording instances listed in the following table.

Call Recording Call Recording a Call Recording a
Limited to Non- three-way Call Supervision four-way
Conference Calls  conference call conference call
9202E phone v v
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Call Recording Call Recording a Call Recording a
Limited to Non- three-way Call Supervision four-way
Conference Calls  conference call conference call
9204 phone v v
9212 phone v
9224 phone v
Verge series v v v
Interact Softphone v v v

The call recording features in the expanded user interface window include the following actions for
both Interact Professional and Interact Softphone:

+ Recording automatically pauses when the user places a call on hold. Recording automatically
resumes when the user resumes the call.

+ Recording automatically stops when parking, transferring, or ending a call.
Users can manually pause and resume recording for any active call from the Status Bar.

Note: When resuming a previously paused recording, this feature inserts a beep/tone into the
recording as a marker and displays a recording indicator.

+ Both applications stop call recording when using a Shared Call Appearance to place the call on a
public or bridged hold. A shared call appearance private hold request works the same as a regular
appearance.

The Record All feature can be set by the Allworx Server Administrator using the Allworx System
Administration web page and when the user navigates to Options > Recording in the settings (%)
drop-down list. This feature automatically captures call recording audio files for all calls from the time
the Interact Professional or Interact Softphone user answers the call or launches the application.
While the Record All feature is active, the recording features — pause/resume/stop — are available as
usual. If there are no available audio channels for recording, both applications display a pop-up
message. When launching either application during an active call with the Record All option enabled,
the application inserts three beeps to signal the start of the call recording and there was previously
unrecorded information from the phone call.

During a phone-hosted conference call, each active call has its own recording file. The recording
feature stops when ending an active call within the conference call or when ending the entire
conference call. To change the Call Recording File Location, Record All capability, or Volume see
“Recording” on page 50.
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To record an active call:

Option Description
Start ([&)) Begins recording the conversation.
To start the recording:
+ Click the start action icon in the top left corner of the Device Status area of the main window.
or
+ Navigate to Current Calls > More > Start Recording.
Pause ([T]) Temporarily stops the recording. The icon changes to the resume recording action icon, and the
applications interrupt recording the conversation.
To pause the recording:
Click the pause action icon in the top left corner of the Device Status area of the main window.
Resume ([J) Restarts recording the conversation. The icon changes to the pause recording action icon, and
the applications start recording the conversation.
To resume the recording:
Click the action icon in the top left corner of the Device Status area of the main window.
Stop ([ Ends the recording, and the application saves the file.

To stop the recording:

+ Click the action icon in the top left corner of the Device Status area of the main window.
or
+ Navigate to Current Calls > More > Stop Recording.

Note: For information about how to set the location for storing the recorded audio files, see
“Recording” on page 50.

5.5  Placing a Call From a Specific Call Appearance or Line
Appearance

The station appearance selected from the status bar drop-down list remains active until another
option is selected by the user.

To select the call type for the outbound call:

1. Click the station appearance drop-down arrow to display the list of available options. Click to
select the option; that option stays active until a different option is selected.

Option

Description

Default Line (by username Place an internal or external phone call.

assigned to that
appearance)

<other available line

appearance>

Place a call using the specific line appearance.

Shared Call Appearance Place a call using a specific shared call appearance line.

Continued
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Option Description

<Bluetooth enabled Place a call using the Bluetooth appearance. Requires the Verge 9312 IP phone.
device>

Intercom Place an intercom call to Allworx directory contacts only.

2. With the appropriate option selected, place the call by using one of the following actions:
+ Open the Dialpad and click each digit to dial the number.

« Click in the Dialpad entry field and use the keyboard to enter the number.

+ Use the dial pad on the Allworx phone when using the Interact Professional user interface.

+ Double-click the appropriate listing in the Contacts pane of the Interact Professional user
interface window.

+  Double-click the appropriate listing in the Call History pane of the Interact Professional user
interface window.

3. Click Call on the Dialpad.
4. Begin talking using the designated Allworx handset, and then click End Call when finished.

5.6 Setting the User Presence

The presence icon in the expanded user interface window shows the user contact availability status. A
presence other than In Office displays the presence status icon for the selected presence. See “Icons”

on page 16.

To change the user presence

1. Click the drop-down arrow in the user presence field in the top left corner of the Interact user
interface window.

2. Click to select one of the following options from the drop-down list.

* In Office * Busy * On Business Trip + At Home
* On Vacation + At a Meeting + Away
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5.7 Adjusting Application Settings

The settings icon provides a menu of options to manage the expanded user interface for both Interact
Professional and Interact Softphone. Click the settings icon (£) to display the drop-down list and then
click to select one of following options:

Allworx Interact Release 5.1 User Guide

Option

Description

Visible Windows

Change the current window view. Use this setting to show or hide windows. When
changing slide-to-hide windows to visible, pinned is the default behavior.

Audio Devices

(Interact Softphone mode
only)

Opens the Audio device selection & Volume controls dialog box. Use the controls in this
box to select the audio devices and ringtone to be used with Interact Softphone and
adjust the volumes (see "Adjusting Volume Levels and Selecting Audio Devices” on
page 34 for more information).

Show Active Call Window / Display or hides the incoming, active call pop-up window, respectively.

Hide Active Call Window

Update Application Request an upgrade from the portal, if available. Click to begin the update.

Update Interact Sync Display only if an upgrade is available. Click to begin the update.

Options Adjust the Call Notifications, Contacts, Display, External Program Link, Interact Sync,
Keyboard & Mouse, Recording, and Support (see “Configuring the Application from the
Options Menu” on page 39 for more information).

View Emergency Alerts Click to display the pop-up window with any active Emergency Alerts (see “Receiving

(Interact Softphone mode
only)

Emergency Alerts” on page 30 for more information).

Change password Update the current Allworx password. See “Changing the Allworx Password or Allworx
PIN” on page 11 for more information.
Change PIN Update the current Allworx PIN. See “Changing the Allworx Password or Allworx PIN” on

page 11 for more information.

Reset Ul configuration

Reset the application display settings to the factory defaults. Click OK to accept the
request.

Launch Allworx View

Open the View application in the default web browser window for more detailed
statistics about queues, agents, and calls. Manage the View application as defined in
the Allworx View Application User’'s Guide.

Find out more Link to the Interact Upgrade Options page.
About Indicate the application version level, copyright, and support contact information.
Logout Sign the user out of the application; enables a new user to log in the application.
Exit Close the application.
5.7.1 Configuring the Application from the Options Menu

The Option Settings pop-up dialog box is accessed from the settings drop-down list and provides
additional configuration features for the all Interact application user interfaces. To open the Option
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Settings pop-up window:

1. Click the Settings icon () to display the drop-down list.
2. Click to select Options.

3. On the left side of the Option Settings pop-up dialog box click a tab to select the option to set.

Option Settings

Call Notifications
Contacts

Display

External Program Link
Interact Sync
Keyboard & Mouse
Recording

Support

Location |Lower Right

Opacity

Duration (softphone) Active calls Timed

Ringing animation Flash Pulse Mone

Ringtone family |Family 6

OK Cancel

4. After configuring the option, click one of the following actions:

Action Description

OK Save the changes and close the Option Settings pop-up window.

Cancel Disregard the requested changes.

Apply Save the changes and allow the user to continue customizing the Interact application.

5.7.1.1 Call Notifications
From this tab adjust the preferences for the behavior of incoming call notifications.

Preference Description
Location Position of the pop-up notification window on the computer screen. Options include:
« Lower Right (default) * Upper Left * Lower Left
* Center * Upper Right
Opacity Move the slider bar to adjust the pop-up notification window transparency.
Duration The length of time the pop-up notification window displays. Options:
« Active calls - When selected, the notification stays open for the entire length of the active call.
+ Timed - When selected, the amount of time in seconds for the notification to remain open must
also be selected in the adjacent field. (Default is 10 seconds)
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Preference Description

Ringing Animation Behavior of the BLF appearance during an incoming call in the Contacts window. Options:
include: Flash (default), Pulse, and None.

Ringtone family The Ringtone family assigned to the call notification. Select from the drop-down list.

571.2 Contacts

Use this option to set the user’s image, manage the personal contacts from external sources, and
import or export personal contacts.

Option Description

My Allworx directory image

Select an image to store on the Allworx server and associate with your Allworx User Contact entry. This is the image that
other Allworx users see associated with your caller ID name/number in the directory listing.

Change the image Opens a file explorer dialog box. Navigate to the directory that contains the
desired image, click to select it, and then click Open to add the image.

Notes:
« This option is not available if the Allworx Server Administrator has disabled
the permission for the Allworx user to manage the contact image.

+ The Allworx Server Administrator can delete an Allworx User’s directory
contact image.

Clear the image Removes the image file and returns the avatar to the contact silhouette.
Outlook Integration
Select whether to have Interact retrieve contact information from Outlook.

Enabled or Disable Indicates the current selected option. Click to select Enable or Disable to
change the option.

« If enabled, the Interact application communicates with the Outlook application
to monitor Personal Contacts for availability in the Interact Professional user

interface.
Enabled or Disable « If disabled, the Interact applications remove Outlook Personal Contacts from
. the Contacts list. Additionally, the Interact Professional user interface does
(continued) not share the Personal Contacts with other Allworx devices and applications.
Contact Accounts

The Interact Professional user interface can display Personal Contacts on all assigned Allworx applications and devices.
Accounts on this device Display local contact locations.

« If the account settings have not been set, click Choose.

« If the account settings are set, click Edit to open the Edit account details
dialog box.

Select one of the available options to change the contact management or click
Forget account to remove the contacts.

Continued
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Option

Description

Accounts on other devices

Display contact locations synchronized from other Allworx devices.

+ If the account settings have not been set, click Choose.

« If the account settings are set, click Edit to open the _Edit account details_
dialog box.

Select one of the available options to change the contact management or click
Forget account to remove the contacts.

Import / export personal contacts

Users can import contacts from a CSV or vCard file into the Personal Contacts of the Interact Professional user interface
which are stored on the Allworx server. Users can also export the personal contacts to a file for backup purposes or to

import into another application.

Import from file

Prior to performing this option: create, save, and close a .CSV file with the
following fields:

Required Optional
+ Description OR Last Name + First name * Login
+ One phone number + Middle name + DID DNIS Name
+ DID Prompt
Language

1. Selecting this option opens a file explorer dialog box. Navigate to the file
location, and click Open.

2. Use the drop-down lists to select how to map the columns in the CSV file to
the contact fields. If the .CSV file contains column headings, verify the First
row contains column headers is checked.

3. Click OK. A confirmation dialog box appears. Click OK to close it, and then
click OK to close to the Option Settings dialog box.

Export to CSV file or Export to vCard
file

Opens a fire explorer dialog box. Navigate to the folder to store the file, and then
enter a File name in the field. Click Save. The Successful export operation dialog
box opens and indicates the number of exported contacts. Click OK.

Refresh contacts

Click to update the Contacts pane in the Interact Professional and Interact
Softphone user interface.

After managing the My Allworx directory image or the Personal contacts from external sources, click
Apply. After all configuration changes are complete, click OK.
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5.7.1.3 Display
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From this tab choose a color theme for the Interact application user interface by selecting the

appropriate radio button. There are two display options available.
+ Light Theme

&

Trarubsrrest

deeemeoan

« Dark Theme

=]

The Display tab also provides Sleep Options. Click the radio button to select one of these options:

« Allow Sleep
+ Stay Awake
+ Stay Awake (Keep Display On)

Preventing the PC from going to sleep keeps users from missing calls.

Cal o ey i Sl
| Call Notifications Select a color theme for the Interact application.
#Light Theme
Contacts

Display
Sleep Options: Interact can prevent your PC from going to sleep, so you don't miss calls

External Program Link ® ) Allow Siaep Stay Awake Stay &wake (Koeo Display Oo

Interact Sync
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57.1.4 External Program Link

Use this option to tie the Allworx phone system into a business work flow. Specify one or more actions
for the Interact software to perform whenever certain phone system events occur and manage
existing actions to new requirements. Click Add a new rule to get started.

Rule 1

Rule name Enter the name of the rule in the field provided. The Rule 1 heading changes to match the
entered description.

Action to perform

Type of action 1. Select an option using the radio button:
» URL - See "To use External Program Link - URL option:” on page 45.
« command line - See "To use External Program Link - CMD Shell option:” on page 46.
2. Enter the URL or command line executable.

Macros Shortcut to include in the command line executable. Options:

Click the drop-down arrow and select an option. Click Insert selected macro to add to the
Command to execute section. Options include:
* %CALLNUM% (phone number of the caller)
* %CALLNAME% (name of the caller)
* %DNISNUM% (DNIS number of the caller)
* %DNISNAME% (DNIS name of the caller)
* %COMPANY% (company name of the caller)
* Only inserts COMPANY when the CALLNUM finds a matching contact in the personal contacts
and the matching contact has a company assigned.
+ Automatically appends CALLNUM to the end of an API string with no macros.
*+ Only inserts DNISNUM and DNISNAME values when available, otherwise the application
inserts a blank.

Macro Expansion Click the arrow to view the drop-down list.
Options * Prepend home area code to local numbers:
Allworx System Software Version 7.7 or lower

Verify the Home Area Code is available in the Dialing Plan. If there is no Home Area code,
enter the home area code.

Allworx System Software Version 8.0

Verify the Home Area Code is in the Dialing Plan.

+ If a Home Area Code is unavailable, enter the home area code.

« If aHome Area Code is available, locate the Prepend the area code <area code configured
on the server> to all local numbers line and check the box.

« Strip the external dialing prefix from all phone numbers - Check to select, uncheck to deselect.
« Strip the country code from all phone numbers - Check to select, uncheck to deselect.

When to perform Check the box to enable the requirement when performing the command. Options include:
this action + Perform on inbound calls + Only execute if a call is answered + Do not execute for internal
+ Perform on outbound - Only execute if a caller is not in calls
calls the contact list

Select appearances Check the box to select the appearances to use the defined rule. Click OK to save the request.

(Advanced) Continued
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Add a new rule Add a another rule to the External Program Link. Follow the options above to enter the required

information in the fields provided. Remember users can:

+ add as many rules as necessary. There is no number limit to adding rules.

+ rename the rule without affecting the rule behavior.

« reorder the rules for processing purposes.

+ use the Copy button to duplicate an existing rule, and then edit the rule separately.
+ delete rules.

The application processes the rules in the listed order and applies all rules on any given call
asynchronously. If a call triggers multiple rules, it is possible that the application executes
multiple (or all) rules simultaneously.

Problem solving

Try an example for Display a sample contact and URL based on the information provided in the Command to
Rule 1 Execute section.

Test this action now  Click to verify that the command is valid.

Action history Click the drop-down arrow to display the list of recently performed commands.

To use External Program Link - URL option:

1. In a separate browser window launch the third-party application to use with the External Program
Link feature. Perform an operation for the information containing one or more of the External
Program Link macros in the Interact Professional user interface.

2. Highlight and copy (Ctrl + C) the URL from the browser window.

Example: Sales Force application Advanced Search using a phone number. www.salesforce.com/
search/SearchResults?searchType=2&str=5854210000&search=Search&sen=0.

3. Navigate to the Interact Professional user interface and paste the URL in the Action to perform field
(Ctrl + V).

4. Replace the macro information (phone number in this example) by highlighting the information

within the pasted URL, locate the Macros line, and select the correct macro key from the
drop-down list. Click Insert to replace the highlighted portion of the URL with the macro.
Example: The section in bold in the following URL is the inserted macro for this example:
www.salesforce.com/search/
SearchResults?searchType=28&str=%CALLNUM%&search=Search&sen=0

5. Repeat step 4 for each additional macro substitution within the same URL.
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To use External Program Link - CMD Shell option:

Enter the following command shell script. The examples below use C:\Program Files\CMS\
CMSSCREENPOP.EXE as an example of the executable command file.

a. For acompletely automated screen pop:

C:\Program Files\CMS\CMSSCREENPOP.EXE /PHONE:"%CALLNUM%" /LOGIN:<username>
/PASSWORD : <userspassword> /LAUNCH

b. For a partially automated screen pop:

C:\Program Files\CMS\CMSSCREENPOP.EXE /PHONE:"%CALLNUM%" /LOGIN:<username>
/PASSWORD : <userspassword>
5.7.1.5 Interact Sync

Use these settings to configure the Interact Sync plug-in to call a Skype for Business contact and
adjust the presence settings.

Click-to-dial options

Contacts in Skype for Business can have up to four associated phone numbers. This section configures the phone
number to use.

Always prompt me for the number to Requires selecting the contact phone number after selecting the Allworx Dial...
dial option.

Automatically dial the following After selecting the contact, Interact Professional automatically dials the phone
number (when possible) number. Select which number to automatically dial:

+ Work Phone + Mobile Phone

+ Home Phone + Other

Presence Synchronization Options

Configure the ways the Skype for Business Availability along with Outlook appointments can affect the Allworx Presence
and phone Do Not Disturb setting. To manage each setting, check the Enabled check box to the right of the heading.

Availability and phone calls

Check the box to enable automatically updating the Skype for Business Availability when using the Allworx phone. After
the call ends, the Availability status returns to the previous setting.

When I'm using my Allworx phone, Select from the following options:
?;od:fy my Availability - Available « Inacall - Inaconference call -+ Be right back
* Busy + In a meeting + Do Not Disturb + Away

Availability and Allworx Presence

Check the box to enable automatically updating the Skype for Business Availability setting with the Allworx presence
setting and vice-versa. Additionally, scheduled meetings on the Outlook calendar update the Skype for Business
application, which updates the Interact Professional application. After customizing the settings, the Skype for Business
and the Interact Professional applications synchronize the Allworx presence and Availability settings.

Continued
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On initial link-up: Select from the following options:
+ Copy my Availability to my Allworx Presence
+ Copy my Allworx Presence to my Availability

When | am in a call in my Skype for Select from the following options:
Business application and my + Do not change my Allworx Presence
Availability changes to In a call: + Change my Allworx Presence to:

+ Away + At A Meeting * Busy
When my PC is idle for a prolonged Select from the following options:
period of time (typically 10 minutes) « Do not change my Allworx Presence

and my Availability changes to Away: + Change my Allworx Presence to:

+ Away * Busy

When I lock my PC and my Availability ~ Select from the following options:
changes to Away: + Do not change my Allworx Presence
+ Change my Allworx Presence to:

+ Away + At Home *+ Busy + At A Meeting

Availability and phone DND setting

Check the box to enable automatically updating the Skype for Business Availability using the Allworx phone Do Not
Disturb setting. When setting the Allworx phone to Do Not Disturb (DND), the Interact Sync changes the Skype for
Business Availability to Do Not Disturb as well.

On initial Link-up: Select from the following options:
+ Copy my Availability to my phone DND setting
+ Copy the DND setting from my phone to my Availability

When I lock my PC and my Availability ~ Select from the following options:
changes to Away: + Do not change the DND setting on my phone
+ Enable DND on my phone

Appointments and Allworx Presence

Check the box to enable automatically updating the Allworx Presence based on new Outlook calendar appointments.

Default Presence for calendar Select from the following options:
appointments « Unmodified + On Vacation + At a Meeting

+ “Show As” based (Outlook feature) + At Home + Away

+ In Office + On Business Trip + Busy
Do not modify my Presence for * Free
appointments with a “Show As: value ~ * Tentative
of:

Continued
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Default Presence for calendar Select from the following options:
appointments

« Unmodified + On Vacation + At a Meeting
+ “Show As” based (Outlook feature) + At Home « Away
« In Office + On Business Trip + Busy

Override options Temporarily disable synchronization between the Microsoft applications and
Allworx Presence.

Locate Ignore Availability changes when | manually set my Presence to:, and
then select the applicable option:

+ On Vacation

+ On Business Trip

+ At Home

Presence change log Display a running log of recent changes to the Allworx Presence and DND for
debugging purposes.

5.7.1.6 Keyboard & Mouse
From this tab users can customize keyboard shortcuts for the following application functions:

+ Answer Incoming Call
+ End Current Call
+ Hold Current Call

When entering the shortcut keys, verify that these functions do not conflict with shortcuts used in
other applications because the shortcuts defined here will affect the PC globally and will work in all
applications; even if Interact is not the primary application in use.

To set a keyboard shortcut:
1. Set the Enabled check box for a particular Command.

2. Click on the Keyboard Shortcut field for that command and simultaneously hold down the key
combination to use.

Repeat steps 1 and 2, as necessary, for each phone action.

4. Click one of the following:

Action Description
OK Save the changes and close the Option Settings window.
Cancel Disregard the requested changes.
Apply Save the changes and allow the user to continue customizing the Interact application.
Page 48 866.ALLWORX (866.255.9679) or 585.421.3850

www.allworx.com
Version: A Revised: October 21, 2020



Allworx Interact Release 5.1 User Guide

G aliworx.

To set the Drag-and-Drop behavior for current calls:

Users can configure the application display to highlight colored targets to indicate the supported drag-
and-drop actions. Click one of the available radio buttons to select the drag-and-drop behavior:

+ Use legacy drag-and-drop behavior: Drag a call from the Current Calls pane to the Contacts or Call
History pane using the:

« Left mouse button to perform a Blind Transfer
* Right mouse button to select an operation from a pop-up menu

+ Use drop targets: Drag a call from the Current Calls pane to the Contacts or Call History pane. Each
contact displays one or more colored targets indicating the supported drag-and-drop operations
onto the target.

While dragging a call, Allworx users can press and hold a key on the keyboard to limit the selection of
drop targets by entering a filter key (alpha characters only) in the fields provided:

Behavior Description Default Keyboard Shortcut
Blind Transfer Win + Shift + B
Attended Transfer Win + Shift + A
To VM Win + Shift + V
Park To Win + Shift + P

Drag-and-Drop Target Examples
Attended Transfer To VM

i

Alwore

’.‘a Anderson, Bianca
1013

B Auto Attendant

»

88 Auto Attendant
00

3‘ —_.‘, Balley, Chatles

W0 "{l! l{llry.thirle-s
n ila:.:lfer.Jay er. Jay Yivn
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5.7.1.7 Recording

From this tab users can specify the storage folder for call recordings, manage the Record All feature,
and set the recording volume level.

Setting Description
Folder to store The folder to store the recordings displays.
recordings in To change the folder location:

1. click Browse and navigate to the new location.
2. Click OK to set the new destination. The file displays in the folder starting with the username
and the date.

Record All Automatically captures audio files from the time the user answers the call or launches the
application during an active call. See “Recording a Call” on page 35 for more information.

Enabled - Click to select this check box if the user can turn on the Record All calls option locally.
The default is Off (unchecked).

Enabled by Server Administrator - This check box is selected if the Allworx administrator has
turned on the Record All option at the Allworx server. Users cannot turn off this setting at the
local level. The pause, resume, or stop icons are available.

Record volume The slider bar adjusts the volume of the recording. Left for a quieter recording and right for a
louder recording.

5.7.1.8 Support

This tab provides fields to enter user optional contact information and instructions for contacting
Allworx (including the location for saving log zip files).

Users can also select their participation in the Customer Experience Improvement Program that
automatically provides feedback to Allworx for enhancements to the Interact application. This
program collects information about how people use the product without interruption to the user's
phone or computer usage. The information collected helps Allworx to identify feature enhances.

If you choose to participate in the program, the Interact Professional user interface collects statistical
information about your system configuration, the performance of some components of the Interact
application, and certain events. The Interact application periodically sends that collected information
over the Internet for analysis by Allworx developers. If you do not want to participate, click to uncheck
the check box.

IMPORTANT: The uploaded data contains no information that identifies you, your company, or your
contacts. There are no surveys to complete; it all happens automatically. If you do not have an Internet
connection, the application discards the data. Allworx does not share this information with other
companies; only Allworx uses the submitted information, in aggregate form, for the purpose of
improving our software for our customers.
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Chapter 6 User Interface Window

Note: The information in this chapter applies only to the expanded user interface window used with
Interact Professional and Interact Softphone.

The user interface window displays up to 9 panes of information that can be independently managed
and customized. This chapter describes the information contained in each pane and provides
instructions on how to implement the associated Interact features.

6.1 Active System Calls

Note: Calls on mapped remote handsets do not display in the Active Systems Calls pane.

The Active System Calls pane displays internal and external calls with the following information:

Field Description
Start time Time of day the call began.
Duration Amount of time the call connection is active.

Originator Caller ID Caller ID starting the call.

Destination Caller ID Caller ID receiving the call.

Click the column heading to sort the information.

Number of Active Calls Hide Active Pane Icon
.
Start Time Duration | Originator Caller ID Destination Caller ID
312:57 PM 0:03:32 ALLWORX CORP (4213850) Jane Smith (1214) Acti linf R
3:13:25 PM 00:03:04  Sally Davis (1107) Frank Lane (1133) 4 ctive call information
3:16:03 PM 00:00:26  Chris Jones (1251) Jay Baker (1131)

To change the Active System Calls pane view, contact the Allworx server administrator to update the
setting for the User System-wide Active Calls Display to one of the following:

Setting Description

Not Displayed The window does not display.

Brief Display (no Caller ID) Both originator and destination caller ID displays as Private
Full Display (with Caller ID) Caller name and caller ID display.
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6.2 Agent: <name>

The Agent pane is available to users who are assigned to a call queue and have an ACD Appearance
PFK (Allworx desk phone) or Programmable Function (Interact Softphone) assigned. Agents can log in
and out of call queues as well as select a busy status using the Interact Professional user interface or
the Allworx desk phone. The Agent pane automatically updates with that agent’s information when
changes are made.

Log in/Log out Window with

. assigned ACD Queues
Login/Logout Queue Badge

Red = no logged in queues Hide Window Button
Blue = number of logged in queues Agent Login/Logout
B allwérx
| Agent Queues
L ) /L t (¥ Agent: JBaker + - X Sales - North America
ogin/Logou
— p| 5o tare
Agent Busy Status ——Pp| idle Logged in queues Hotline - North America
1. Sales - Morth America -
Can change to: Break 2.Sales - Europ Promos - US Hotline
Sl o e
I e-> BUSy Resezrch «_I‘F'lcrrcs-US Hotline
* BUSy -> BUSy Meeting QIZE: EEF; tt_ Tech Supp - LVL 2
. - - Other 7.Tech Supp - LVL 3 Tech Supp - LVL3
Wrap-Up -> Busy i
' Wrap-Up > Idle T Allworx Extension
amorcen [ ]
Agent Selectable Status
. ancel
Hover over Login/Logout button

to see logged in queues.

To log in or log out of a call queue:

1. Click Login/Logout. The Agent Login/Logout dialog box appears and displays a list of assigned call
queues.

2. Click to check or uncheck the box to select the call queue(s) to log in to or log out of, respectively.
Click in the Allworx PIN field and enter the assigned Allworx PIN.
4. Click Apply.

After logging into one or more call queues, the Login/Logout button displays a blue badge. The
badge indicates how many call queues the agent logged in to. A red badge with the number 0
displays when the agent logs out of all call queues. To see the queues the agent is logged in to,
hover the cursor over the badge on the Login/Logout button. A red flag next to the Allworx PIN field
indicates an invalid PIN number.

Page 52 866.ALLWORX (866.255.9679) or 585.421.3850
www.allworx.com
Version: A Revised: October 21, 2020



eallv@.,

To set or clear the agent status:

Allworx Interact Release 5.1 User Guide

After logging in to one or more call queues an agent can set the agent status to Busy or Idle.

Note: The Interact agent cannot change the following Busy States: Ringing, Call on Hold, Administration
Functions, and On Call.

Click the button displaying the agent status and select the new agent status option from the drop-
down list.

6.3 Call History

The Call History pane loads the user’s call history when first opening the application and then
continues to provide a listing of the current call history size. For Interact Professional, Verge IP
phones support 200 entries / 92xx IP phones support 99 entries. For Interact Softphone the maximum
number of entries in this pane is 200. The pane updates with each call and deletes the oldest Call
History entry as the application adds new entries to the list.

Call History listings include: the caller ID (red text indicates a missed call), date/time of the call, and
status icons. If minimizing the Call History pane so that only the contact image and caller ID name/
number display, hover over the listing to see start date/time and duration of the call. Use this pane to
place a call, search, change the display order, or clear the call history list.

= Fe 4— Hide Window Icon
Search Field m ¢— Use drop-down arrow to manage:
R + Display Order
Call History Listings ——— n A S " * Search By
+ Search Preference
+ Caller image (if "B Frank Lane A . Olear Histor
available), red corner aia 1133 © Ended y
indicates Allworx )
. SallyH D i /71
business directory n i " No Answer
contact. P —
+ Caller ID Name/Number M 1131 Elsewhers
+ Call information Sally H Davis — A
° Ca” status J 107 Mo Answer
Sally H Davis 141172017 L
1107 Missed
Unknqwn 141 /-’1
=4 4215526 Check Number L
Call Status Description
Transferred Call forwarded to another recipient
Ended Normal call ended
Parked <orbit number> Call placed into a Parking Orbit
Parked <extension> Call parked to a specific extension
No Answer Outbound call that is not answered (internal calls only). Continued
866.ALLWORX (866.255.9679) or 585.421.3850 Page 53

www.allworx.com
Version: A Revised: October 21, 2020



Allworx Interact Release 5.1 User Guide e a I Im

Call Status Description
Missed
Check Number

Inbound call that rings, but it is not answered.

Failed to route to an outbound call

Elsewhere Missed inbound, picked up somewhere elseg, i.e., Reach Device

To manage the Call History listings:

1. Locate the Call History listing and right-click on that listing.

2. Select an option from the drop-down list:

Option Description
Intercom
Dial

Place an Intercom call to the listing.

Place a call to that listing. Shortcut: double-click that listing.

Add to Contacts Open the Edit contact details dialog box.
« Enter or update the information.
+ Click OK to add the information as a Personal Contact.

Delete entry Clear that specific listing from the Call History pane.

Delete all Clear the entire list from the Call History window. Click Yes in the confirmation
dialog box to perform this action.

Details

View the Call History listing details - call date/time, caller/contact ID and number,
call duration, and network statistics.

Select one of the following actions after opening the Call History Details dialog box:

Action Description
OK

Close the Call History Details dialog box.

Add to Contacts Opens the Edit contact details dialog box. Enter or
update the information and click OK to add the
information as a Personal Contact.

Delete entry Removes the listing from the Call History pane.

To complete a search within the Call History pane:

Provide criteria in the search field to locate a specific call history listing.

1. (optional) Click the drop-down arrow next to the search field (indicated by the @ icon) to select
one of the following search preferences.

Preference Description

All Fields (Default) Display listings with any field matching the search criteria.

Full name Display the caller ID names matching the search criteria. Continued
Page 54
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Preference Description
Number Display the caller ID numbers matching the search criteria.
Date/Time Display listings with a date/time stamp matching the search criteria.

2. Enter the search criteria in the field. The application automatically displays the call listings that
match the search field information in the Call History pane.

To clear the search field criteria, click the X that appears at the right end of the field.

To change the Call History pane display order:
Select how the Call History pane displays the listings.

1. Click the drop-down arrow next to the Search field and select Display Order from the menu.

2. Select the preference. The Call History pane updates the view according to the selection.

Option Description

Name Display the Call History listing by caller ID name.

Number Display the Call History listing by caller ID number.

Time Display the Call History listing with the most recent call on top. (Default setting)

To clear all calls in the Call History:
1. Locate the Call History pane.

2. Click the drop-down arrow next to the magnifying glass ( Q).
3. Select Clear History from the list.

Note: Performing a Clear History also clears the Handset Call History.

6.4 Contacts

The Allworx System supports four types of contacts on the Allworx® Verge™ IP phone series and on
Interact Softphone handsets:

+ User and System contacts — These contacts have an internal Allworx extension assigned and are
managed by the Allworx Server Administrator.

+ Public Contacts — These are system-wide contacts (formerly known as Speed Dial (for Verge
phones) and are managed by the Allworx Server Administrator.

Personal Contacts — These contacts are managed by the Allworx user and are only available on
Allworx systems with a Connect server.

« Allworx Personal Contacts

+ Created from the Verge IP phone, the Interact application, or a Reach device contact
application.
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Imported from a .CSV file or vCard within the Interact Professional user interface.

« External Personal Contacts

Synchronized from a Reach device originating application (device app such as Contacts or
People)
+ Synchronized from an account such as a Gmail or Outlook email account.

Allworx Interact Release 5.1 User Guide

Visual example of Contacts:

Personal
Contacts

Allwaorx External
Personal Personal
Contacts Contacts

Allworx
User
Contacts

Allworx
System
Contacts

Allworx
Public
Contacts

6.4.1 Sharing Contacts

The Allworx system shares the User, System, and Public contact types with all of the Allworx user’s
connected Allworx phones, Reach devices, and the Interact application modes. Within the Reach and
Interact application modes, Allworx users control sharing and synchronizing Personal Contacts with
the devices assigned to that Allworx user.

Notes:

« The Allworx Connect server is not a contact manager for Personal Contacts. Example: If a Personal
Contact is available in the Reach device app (i.e. Contacts) and the same Personal Contact is
available in the user’s email account (e.g. Gmail), the Personal Contact displays twice when viewing
the contacts.

« The expanded Interact user interface only exports contacts added from within an Allworx
application.
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+  For Interact Professional, the Verge 9304 IP Phone fully supports Allworx User, System, and Public
contacts while having limited Personal Contact support. Allworx users can add up to 100 Allworx
Personal Contacts that are only available with that phone - not with other Allworx phones and
applications (including when using the Hot Desk feature).

+ Interact Professional offers full contact support on all phones connected to a Connect server.
Certain phones (like the Verge 9304 IP Phone, or older Allworx 92xx phone models) have limited
contact support within the phone (these phones do not automatically match contacts synchronized
from Reach or Interact applications), but the Interact Professional application mode offers full
contact support even when used with those phones.

Visual example of sharing contacts using a Connect server:

@.'.--

.

-
» e
k. -
®

* Contact Source NORX Vg,
o n :  Accounts > PG& oo R g

.NORXE‘Eq
W & 7
s T i 12

o) e

o cime [| () () ) () o N

Corporate Directory
+ Public Contacts

STOREDIN THEALLWORX CONNECT SERVER

6.4.2 Contact Privacy
Allworx users control sharing and synchronizing the Personal Contacts to the devices assigned to the
user by clicking the Settings icon (£¢) and navigating to the Options > Contacts dialog box:

+ Choose which contact source accounts (e.g. Outlook) to share with your Allworx devices and
applications.

« Disconnect a contact source account from other Reach devices.
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6.4.3 Data Protection

Only the Allworx user has access to their Personal Contacts; the Allworx Server Administrator cannot
access the user’'s Personal Contacts. Allworx Interact Professional users can prevent others from
seeing the personal contacts on their Verge IP phone by restricting access. This requires the Allworx
PIN to unlock the Verge IP phone.

6 alivorx

6.4.4 Managing Personal Contacts

Allworx users can manage and update Personal Contacts by using the originating device or external
application (e.g. Microsoft Outlook, Gmail). Only the Allworx user can add, edit, or delete each
Personal Contact. However, Allworx Server Administrators can delete all of a user’s personal contacts
from the Connect server permanently, but cannot limit an individual user’'s number of Personal
Contacts stored on a Connect server.

Note: The Reach application allows users to update an External Personal Contact IF the email account
(e.g., Gmail) used to create the contact is available on the Reach mobile device. However, the Reach
application does not allow users to update External Personal Contacts synchronized from the Interact
Professional user interface using Outlook email.

Example:

Jane Smith needs to update her Personal Contact, Tom Wright. Because Jane uses the Verge IP
phone, Reach for i0S, and the Interact Professional application with Softphone, she needs to
determine how she added Tom to her Personal Contacts. Within the Interact Professional user
interface, Jane opens the Contact pane and scrolls to find Tom Wright. Jane hovers the mouse over
Tom and locates the Account and Devices lines to learn how she added Tom to her Personal Contacts.

|
I q Johnson, Sarah
-
Jones, Chris
140 *
i JF Key System Ring Delay
n King, Olivia N E
1113

" Lane Frank
a 1133

O Martin, Maryanne G
1106

el Miller, Jeff
J;;u 5854213049
(] ar, Mark

37

£

3‘ Mills, Tim
S85-555-1216

Mom

SA5-471-3054)
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If the Account line reads:

Allworx Personal: Jane added Tom Wright using her Verge IP phone, Reach device, or Interact
application. To update the contact information about Tom, Jane can use her Verge IP phone, the
Reach application or the Interact (Professional) application. Example: Allworx Personal

Allworx User, Allworx System, Allworx Public* — The Allworx Server Administrator manages these
contacts using the Allworx System software. Example: Allworx Users

Source account: Jane used Reach or Interact to synchronize her contacts with her Verge IP phone.
There are three synchronized contact labels that may display:

Email account: Jane used the Reach application to synchronize her contacts from her email
account (such as Gmail). To update the contact information about Tom, Jane must do so in her
contacts application. Example: username@gmail.com

Reach device: Jane used an iOS or Android app (such as Contacts) to manage her contacts
stored on her device, but the contacts are not associated with a third party service. To update
the contact information about Tom, Jane must do so on the identified device in the appropriate
Contacts app on the device synchronizing with the Allworx System.

Note: Reach for iOS version 11 or higher will look like these contact types due to iOS 11
restrictions. Example: <Samsung SM-T530NU>.

Outlook account: Jane used the Interact Professional application to synchronize her contacts
from her Outlook account. To update the contact information about Tom, Jane must do so in
her Outlook application. Example: Outlook:\\PersonalFolders\Contacts.

* The only user-editable options for these contacts types are the Favorite status and the choice of

default phone number on the Verge IP phone, Reach application or Interact application.
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6.4.5 Contact Pane Overview

Use this pane to view or group the contacts, designate favorite contacts, add a new Personal Contact,
and adjust the view. Expanded Interact user interface users can place calls, search the contacts using
specific criteria, and change the display order.

Standard View with High Visibility Display Hide Pane Icon

View increase or

Contact Group Tabs I—Add new Personal Contact

Search Field — ¥ Drop-down arrow to select:
+ Display Order
System Contact ———— [ /utoAttendant « Display Visibility
« Favorite 00 » Search By
+ Parked call notifications {(<]] Bailey, Charles v . Search Preference
(if available to the user) A
+ Dial H e Personal Contact
* Intercom « Favorite
» Details [ Barnes, Phyllis Z -7 * Dial
el  x1125
* Details
C , Lori H

User Contact A St x I gd'lt fogta(it .

. + Delete Contac
» Favorite '& Collins, Susan * <
« Parked call notifications X353 (94211234) |_

(lf available to the USGI') '& Conference Center Public Contact

+ Dial o8 + Contact Avatar
. Intergom + Allworx Badge
+ Details

« Contact Name / Number
+ Speed Dial / Contact Number
+ Favorite

Ultra Condensed with Low Visibility Display

L Contacts — O X

F Y
Administrator, Sy.. 1122 ALLWORX *
- -
Anderson, Bianca 1126 ¥ Auto Attendant 400
,
IBaiIey. Charles v Baker, Jay
o i L. ik -
¥ ” ”*
Clark, John Collins, Mary Jane 250

- -
Conference Center 408 Cook, Louis U 120

Each contact listing displays a contact image (if available), caller ID name / number, and the favorite
status. Personal Contacts display the company name (if available). User Contacts display icons to
indicate a presence status for other than In Office (see “lcons” on page 16) and an availability status
using color-coded BLF status information.
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Color Description Color Description
Normal (Black) Handset is idle. Red (flashing)* Handset is ringing.
Red (solid)* Handset is on an active call. Amber Do Not Disturb.

* |f the Allworx User Contact is busy, set the Interact Professional user interface to Notify when available. When the

Allworx User Contact's extension is available, a pop-up notification displays. See “To place a call using the expanded user
interface Call History or Contacts pane:” on page 22.

Hovering over a contact displays a pop-up window with the following information:

User, System, or Public Contact Personal Contact

+ Contact image, if available

« Caller ID name and number

+ Current status / Presence

« Call duration (active call only)

+ Contact image, if available

« Caller ID name and number

« Company name, if available

+ Account - the source account used to create the contact

« Device - the device used to create the contact - this field is

visible only for contacts imported from Android, iOS, or
Outlook.

To change the Display Visibility within the Contacts pane:
1. Click the drop-down arrow next to the search field and click to select Display Visibility from the list.

2. Select the High Visibility (highlights the entire User Contact Listing) or Low Visibility (changes the
User Contact listing text color) radio button.

To use the Contact group tabs:

Each group tab adds or removes contact entries from the list. Clicking the group tab toggles the

contacts view on and off independently of the other group tabs. The group remains active after
closing and reopening the Interact Professional user interface.

Group Description

Favorites ( ) Display only Favorite contacts from business and Microsoft Outlook directories.

User Display the Allworx contacts assigned to an Allworx desk phone or Interact Softphone.
System Display the Allworx Call Monitor, Call Queue, Auto Attendant, and System Paging Zones.
Personal

Display the contacts synchronized from a Reach device, a Verge IP phone, or Microsoft Outlook.
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To designate favorite contacts:

A blue star ( 7% ) displays in the contact listing to indicate that the contact is a favorite. To designate
or remove a contact as a favorite, click on the star icon in the contact listing or right-click the contact
listing and select Favorite from the drop-down list.

To add a new Personal Contact:
Users can add new Personal Contacts from the Contacts pane.

1. Click the new Contact () icon to open the Edit contact details dialog box for the new contact.

2. Enter the required information in the fields provided. Click add phone number to open another
space for an additional phone number to be included in the Contact information. Click Add an
image to upload an image file from your computer.

3. Click OK.

The new Personal Contact displays in the Contact pane.

To edit or delete a Personal Contact:

Users can only edit or delete Personal Contacts that were created from within the Interact application,
Reach application, or on a Verge IP phone. Right-click the contact listing in the Contacts pane and click
to select one of the following actions:

Action Description
Edit contact Opens the Edit contact details pop-up window. Enter the updated information and click OK.
Delete contact Displays the Delete a personal contact pop-up window. Press Yes to remove the Allworx

Personal Contact. Click No to stop the deletion.

To adjust the contact listing display:

Click a view adjustment icon to alter the size of the contact listing density from a single-row to multi-
column format. To identify the user status:

Option Description

High Density This ultra condensed view displays a single-line entry with the username, phone number, and the
favorite status icon in a multi-column format based on the width of the pane.

Medium Density This standard view displays two lines of information that include the image (if available), name,
phone number, and favorite status icon in a multi-column format based on the width of the pane.
E A Microsoft Outlook contact has three lines of information that includes the company name, if
available.
Low Density This view displays a single column listing of the contacts with the image (if available), name,

phone number, company (if available), and favorite status icon.
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Right-click on a Contact listing and select one of the following options:

Option Description

Dial Places a call to that listing. If more than one phone number is available, select a number from the drop-down
list.

Intercom  Place an Intercom call to that listing.

To pick-up another user’s call from the Contacts pane:

For incoming calls, the contact flashes red. Right-click the contact and select Answer from the
drop-down list to pick-up the call.

To specify the primary number of a personal contact:
1. Right-click the contact listing and select Details from the drop-down list.

2. Locate the contact’s phone number, and click to select one of the available phone numbers.

3. Click Done to save the changes.

To change the Contacts pane display order:

When changing the contacts display order, the selection remains active after closing and reopening
the application.

1. Click the drop-down arrow next to the search field.

2. Click to select the Display Order in the drop-down list.

3. Click the radio button to select one of the following display preferences. The application window
updates the view per selection.

Option Description

First Name Arrange the contacts by the caller ID first names.

Example: First name, Last name.

Last Name Arrange the contacts by the caller ID last names. (Default)

Example: Last name, First name, Middle name. (Default)

Company Name Arrange the contacts by the Corporate names (Microsoft Outlook contacts only)

Example: Company name, Last name, First name

Number Arrange the contacts by the caller ID number.

Example: Caller ID number, Last name, First name
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To search within the Contacts pane:

Note: The selected search preference is still active after closing and reopening the Interact Professional
user interface.

1. Type the search criteria in the field. The application returns any contact listing containing the
search criteria.

(optional) Click the drop-down arrow next to the search field and click to select Search Preference.

Click to select one of the following preference radio buttons.

Option Description
Contains Display the contact listings with any of the search criteria.
Starts with Display the contact listings that begin with the search criteria.

4. (optional) Click the drop-down arrow next to the search field and click to select Search By.

Click to select one of the following search by radio buttons.

Option Description

All Fields (Default) Display listings with any field matching the search criteria.

Full name Display the caller ID names matching the search criteria.

First Name Display the caller ID first names matching the search criteria.

Last Name Display the caller ID last names matching the search criteria.

Company Name Display the Corporate names matching the search criteria (from Microsoft Outlook
only).

Number Display the caller ID numbers matching the search criteria.

Note: To clear the search field terms, click the X icon that appears in the right side of the field.

6.5 Current Calls

The Current Calls pane displays all active calls and calls on hold for the Allworx desk phone or Interact
Softphone connected to the Interact Professional user interface, as well as parked calls for Allworx
contacts when the user has enabled Parked Call Notifications for that contact. Additionally, users can
place a call on hold, transfer a call, create a conference call, or end the active call from this pane.

The applications automatically search the Personal Contacts during a new call and display the contact
name if the number matches any of the numbers in the contact number list.

Note: You can close the Interact Professional user interface without affecting the current phone state
such as disconnecting the current call.
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Number of Current Calls

L9 v l¢— Hide Pane Icon

4 ALLWORX CORP o012s |l Line #1 Information

D15854213850 . .
+ Caller Image, if available
End Call | Hold | More 1 * Current State
1 Johnﬁ_\II;n 0:00:54 * Caller ID Name
139 o + Dialed Number Identification Service: the telephone
tnd Call | Resume number dialed by the caller

+ Call Duration
+ Call Management Buttons/Drop-down Menu

Line #2 Information

+ Caller Image, if available

+ Current State

+ Caller ID Name

+ Caller ID Number

+ Call Duration

+ Call Management Buttons

To avoid disconnecting a call when answering a second incoming call, it is recommended that your
Allworx System Administrator configure your phone’s Handset Preference Group to enable Auto On
Hold, or you can configure your Allworx desk phone as indicated in the following table.

Phone Phone Navigation

92xx IP Phones CONFIG > Preferences > Auto On Hold. Select Enabled and exit the menu. When
prompted to Save to Flash, press the Yes soft key.

Verge IP phone series Settings > Phone Preferences > Call Handling > Auto On Hold. Select Enabled. Press

Back to return to the Settings screen and Back again to return to the Idle screen.

Call Reminder notifications are available to alert users when calls placed on hold have not been
answered. These notifications are defined by the Allworx system administrator in the Handset
Preference Group and assigned to the handset using the Allworx System Administrator web page (see
the Allworx System Software Administrator Guide for information).

When a call is placed on hold, that entry in the Current Call pane is highlighted, labeled with the
message Privacy Hold, and an audible reminder plays at the intervals defined in the Handset
Preference Group. When the user resumes the call the intermittent sound stops, the Current Calls pane
entry is no longer highlighted, and the Privacy Hold message disappears.

Current Calls (1) o =
£ Privacy Hold
e Bill Jones 038
o

End Call | Resume | More w
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To place a call on hold:
See “Placing a Call On Hold” on page 27 for more information.

To park a call:
See “Parked Calls” on page 72 for more information.

To transfer a call using the expanded Interact user interface
1. Locate the Current Calls pane and then the current phone call.

2. Click the More drop-down arrow and click to select one of the following transfer options:

Option Description
Blind Transfer Place the call unannounced to an extension or external phone number.
Attended Transfer Place the call announced to an extension or external phone number.

Transfer to my voicemail Place the call directly to that user’s voicemail. This option only: The call transfers
immediately and no longer displays in the Current Calls pane.

Transfer to voicemail Place the call directly to another user’s voicemail.
System Park Place the call in a Parking Orbit. The Parking Orbit number for a short period of time.
Park To Place the call into a parking location for a specific user or group (if this feature is

enabled for users with Allworx System Software 8.5 and higher).

3. Click alisting in the Contacts, Call History, or Current Call pane or use the Dialpad. The call
transfers.

Transfer Actions: Use the following actions to quickly transfer calls.

Action Description

Left click and drag Perform a blind transfer by moving the call to a listing in the Call History or Contacts pane.
Release the left mouse button to immediately connect the two calls.

When Use drop targets is enabled (default), the call is dragged to the Contact listing in either
pane, the listing highlights with several colors. Drag the call to the blue area to complete an
Attended Transfer, to the yellow area to complete a Blind Transfer, to the green area to complete
a Park to, and the pink area to complete a transfer To VM (voicemail).

a Anderson, Bianca
Al 1013

Continued
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Action Description

Right click a Call Manage a listing in the Call History pane by selecting one of the options from the drop-down list:
History listing « Dial - Place a call to the selected listing.

+ Intercom - Place an Intercom call to the selected listing.
+ Blind Transfer* - Immediately connect the two calls.

+ Attended Transfer* - Displays a second call listing in the Current Calls pane. After the target
answers select one of the following options:

« Transfer - complete the transfer

 Try Again - drop the current Transferee, and the call is available for an Attended Transfer to
another listing.

« Cancel - drop the current Transferee, and the Transferor is able to route the call as
necessary.

+ VMail Transfer (Allworx Directory only) - place the call directly to the transferee’s voice mail
box.

Right click a Contact =~ Manage a listing in the Contact pane by selecting one of the options from the drop-down list:
listing « Favorite - Mark the contact as a preferred listing.

+ Dial - Place a call to the selected listing.

+ Intercom - Place an Intercom call to the selected listing.
+ Blind Transfer* - immediately connect the two calls.

+ Attended Transfer* - display a second call listing in the Current Calls window. After the target
answers select one of the following options:

« Transfer - complete the transfer

« Try Again - drop the current Transferee, and the call is available for an Attended Transfer to
another listing.

« Cancel - drop the current Transferee, and the Transferor is able to route the call as
necessary.

VMail Transfer (Allworx Directory only) - place the call directly to the transferee’s voice mail
box.

» Park To - Place the call into a parking location for that contact (if this feature is enabled for the
user with Allworx System Software 8.5 and higher).

+ Details... (Outlook personal directory only) - open the Contact Details window for the user to
select the primary phone number.

* The user interface guides the user to potential transfer targets.

** Available only to an Allworx Contact listing.

866.ALLWORX (866.255.9679) or 585.421.3850 Page 67
www.allworx.com
Version: A Revised: October 21, 2020



Allworx Interact Release 5.1 User Guide e a I Im

To create a conference call:
Set up phone-hosted conferences between three parties (3-way conferences).

1. Place the active call on hold.

2. Place or receive a second call; the Current Calls pane displays both calls.

3. Click the More drop-down arrow, and select Conference from the drop-down list to join all callers.
This connects both calls to a single, active call and the display shows both calls as in conference.

Note: Placing a call on hold temporarily removes the caller from the conference. To rejoin the
conference, repeat step 3.

%, Current Calls — e %, Current Calls — X
Jo hn };\Ilen 0:00:29 Joghn Allen 0:00:07
1139 9
End call | Resume > End Call v| Hold | Start Re..
Jef'fP Collins 00021 Jef;f PCoIIlns L0007
End CaI-I | Hold End Call v| Hold | Start Re..
Blind Transfer

Attended Transfer

Transfer to my voicemail

Transfer to voicemail
[omee ]

Park

Start Recording

To end a conference call using the Interact Professional user interface:

In the Current Calls pane, locate a call segment and click End Call. Select one of the following options
from the drop-down list:

Option Description

End This Call Disconnects the specific active call participating in the conference call, and the active
call no longer displays in the Current Calls pane. The other active call(s) in the
conference remain active, and the Current Calls pane remains open.

End Conference Disconnects all active calls participating in the conference call. The pane closes -
unless it is pinned open.

Continue without me Disconnects the user from the conference call while enabling the other callers to
continue their conversation. After selecting the Continue without me option, the status
of the active calls in the Current Calls pane updates to Calls Connected, and then the
pane closes (unless it is pinned open).

The Interact Professional application mode does not support this feature on four-way
conference calls.
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6.6

Dialpad

Use the Dialpad pane to place a phone call.

Dialing Display Field ——p

Call Active Icon >

<— Hide Pane Active Icon

’-| 2:\8(3 3 DEF
4(}!—' bJK. 6 MMNO
/ PORS 8T.,\u' gwxvz

* Donsn ',"'I."'

To place a call using the Dialpad:

1. Open the expanded Interact user interface Dialpad pane.

2. Dial the number using one of the following options:

Dial the internal extension.

Follow the dial plan for an external number. To dial an external number, dial the outside line
access digit set in the dial plan (usually 9 or 78 + Allworx pin code).

Immediate line seizure example: 9# or 78 + pin code# > Call > phone number
Call connect example: 9 <phone number> or 78 + pin code <phone number>

Right-click on the Dialpad entry field and select one of the drop-down options or use the PC
keyboard to enter the numbers

Copy text into the Dialing Display Field using Ctrl + v or a right-click.

3. Click the Call active icon to place the call. The Dialpad pane is available to dial additional digits
during a call (example: Auto Attendant options or PIN entry for the Message Center) without
needing to press the Call active icon.

Shortcut: Double-click the Call active icon to redial the last number.

4. When the call is dialed, the Call active icon changes to an End icon - click that icon to end the
current call.
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6./ Messages

Note: This pane is available only when using the Interact Softphone mode.
The Message pane alerts users when a new Voicemail message is received. The pane displays both

the number of new messages available from within the pane or by dialing the Message Center. The red
number icon displays the number of new messages.

L ontacts

ﬁ B ..l .. ._ ...I:- 'I.. .. - I E

Just like other Interact Softphone panes, the Messages tab can be opened and pinned in the user
interface. When open, the pane displays a list of messages in a reverse-chronological order with the

Caller ID in bold, and standard play * and stop ™ controls.

B x Y Parked Calk x § Current Calls

'e Chirs Jones
04/23/2020 1:37:12 PM [00:06)

e 01/28/2020 2:04:04 PM [00:00) i Chirs Jones
1015

Note: New Voicemail message alerts are also displayed in the basic Interact window that displays in the
lower right corner of the user’s PC.

To listen to Voicemail messages:

1. Click the playicon * to listen to a message.

2. Click the stop icon ™ to end the playback.

3. Right-click on a message to display the drop-down menu.

2 M Messages
5 'B Chirs Jones .
= 04/23/2020 1:37:12 P N
E fe Callback (1015)
[1-] :
A i Chirs Jones Mark Read
9 01/28/2020 2:04:04 P Delete

4. Click Callback to return the call.

5. Click Mark Read to indicate that the message has been read and remove it from the new messages
count displayed on the tab.
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6. Click Delete to remove the message listing from the pane. There is NO warning when deleting a
message — as soon as Delete is selected, the message is removed from the pane.

Note: You can also call the Message Center by dialing 404 in the Dialpad pane. Enter the user PIN and
use the Dialpad pane to follow the audio prompts to manage messages.The number of messages
displayed in the Messages pane is updated based on the user’s selections.

6.8 Outside Lines

The Outside Lines pane provides visual indication of which outside phone lines are in use and is only
available if the Interact Professional user has an outside line assigned to the handset. Use the Outside
Lines pane to answer incoming calls, seize a line for outgoing calls, drag-and-drop an external contact
or listing from the Contacts or Call History pane to place a call.

Use this pane to place an call or answer a call.

%+ <¢—— Hide Pane Icon

Available outside phone line: ——pEERNEEEFNITEEES (sales - North America #2)

Blinking — red lines are ringing.
Solid - red lines are unavailable.

s i Y s i Y
[ Widgets Inc - 05 I Widgets Inc - 09 |

s i Y s i Y
[ Widgets Inc - 13 I Widgets Inc - 17 |

_rJ- . -.\'\
[ Widgets Inc - 01 |

To place a call:
A red highlighted phone line option indicates that the line is unavailable.

1. Open the Outside Lines pane.

2. Select one of the following options:

Option 1 Option 2

1. Click on an available phone line. 1. Locate the Contacts or Call History pane, and then
) . locate the external contact.
2. Locate the Dialpad pane. Enter the number and click o Drag and drop the contact to an available line in the

Call. Outside Lines pane.

3. Use the Current Calls pane to further manage the call.

To answer a call:
1. Open the Outside Lines pane.
2. Click the red, blinking phone line.

3. Use the Current Calls pane to further manage the call.
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6.9 Parked Calls

Place a call in a system-wide hold location so that another phone can retrieve the call. The Allworx
System provides two methods to park a call:

« System Park: Place a call into the next available park location, and then a different phone can
retrieve the call by dialing the park location number.

Example: Park a call for someone away from their phone, and then page the recipient to tell them
to retrieve the call by dialing the parking orbit.

+ Park to Extension: Place a call into a parking location for a specific user or group, if enabled
(available in Allworx System Software 8.5 and higher). Allworx users also receive Parked Call
Notifications, if someone parked a call on their extension or any extension of interest.

To Park a call when using Allworx System Software 8.5 or higher:
Locate the call in the Current Calls pane, and then do one of the following:

* Inthe Current Calls pane, click the More drop-arrow, and then select one of the following:

System Park Place the call into the next available parking location for any Allworx
phone to retrieve.

Park To Place the call into the next available parking location for a specific
extension. Use the Contacts or Call History pane to select the contact
number to which the call is parked.

Note: The panes display only the Contacts with Park to Extension enabled.

Click and drag the current call to the Parked Calls pane to one of the following drop targets:

System Park Place the call into the next available parking location for any Allworx
phone to retrieve.

Park To Myself Place the call into the next available parking orbit for this extension.

+ Click and drag the current call to the Park To area of the Contacts or the Call History pane. Contacts
with Park to Extension enabled display the Park To target. To show only parkable extensions, press
a filter key (default P) while dragging the call.

To park a call when using Allworx System Software 8.4 or lower:
Do one of the following:
« Drag and drop the call listing in the Current Calls pane to the Parked Calls pane.

* Locate the Current Calls pane and then the current phone call. Click the More drop-down arrow, and
select Park from the drop-down list.

In any Allworx System Software version, after the Allworx phone parks the call, the Parked Calls and
the Current Calls panes update with the call listing.
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To retrieve a parked call:

Locate the call in the Parked Calls pane and click Retrieve or double-click the listing. The Allworx
System allows retrieving any parked call in the Parked Calls pane.

Interact Professional and Interact Softphone Park Examples (Allworx System Software 8.5 and
higher):

Current Calls pane > Parked Calls pane Call History pane >
More drop-down arrow options Park To Target Available
]
WO Charles Bail 2 3
‘?‘ |_-.-_-TI es Bailey Y
%®Y Bianca Anderson
1013
Jeremy Young

119

Ended

System Park 8 | Charles Bailey
'% ! Parked 1107
Jay Baker /
Contacts pane > i Ended
Park To Target Available WO Charles Bailey
= = = e Ended
| f e Sy Perend LRGN | Sally Davis 7
o

Ended

6.9.1 Parked Call Notifications

The Park to Extension feature notifies users configured to receive parked calls or Park to Extension
recipients of interest about a parked call.

Example:

After the Allworx Server Administrator enables the Park to Extension feature on Bob’s extension, Bob's
devices automatically notify him when someone parks a call to his extension. In addition, if Bob has a
Park to Extension programmable button on his Verge phone for the Sales Department, the Allworx
System automatically notifies Bob of any calls parked on the Sales Department extension.

The Interact Professional notifications include:

+ Notification pops up similar to an incoming call notification
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+ Updated Parked Calls pane (All parked calls enabled) with the Parked Calls listing
« Updated Current Calls pane with the Parked Calls pane listing and a parked status

Parked Call Notification Examples:

Parked Calls = M Current Calls (1)
2 f , e Smith (1214]

! Befrieve

A For me (1)
Parked for Jane Smith {1214)

Jay Baker 003:56
A

To enable or disable the parked call notifications:
1. Locate the Contacts pane.

2. Right-click the contact listing and then click to select the check box to enable Parked call
notifications, or click to de-select the check box to disable notifications.

6.9.2 Parked Call Listings

The Parked Calls pane displays parked calls. In Allworx System Software version 8.5 or higher, the
Allworx Server Administrator sets the Parked Calls pane display for viewing the following the types of
parked calls in the order listed with the longest park time at the highest level for each category.

Allworx System Setting
All Calls Limited

Calls parked for the phone owner

v v
Calls parked using this phone v
Calls for system extensions enabled for notifications v
Calls for user extensions enabled for notifications v
Calls parked for the extension of configured Park to Extension programmable v
buttons
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Allworx System Setting
All Calls Limited

Calls matching a System Extension Contact (example: Sales Dept) without

notifications v
Calls for user extensions without notifications v
System parked calls v v

Note: Allworx phones do not provide notifications for calls that are not eligible for the parked calls list
on the phone, even if the owner has set the notification flag for other contact with parked calls.

When viewing many parked calls, users can use the search field to locate a specific call by entering
one of the following criteria:

+ Recipient’s extension contact name
+ Caller's caller ID
* Recipient extension

Parked Call Listings Example:

All parked calls:
displays all Parked
Calls on the Allworx
System.

Parked by me: displays only the calls
parked by the Interact Professional user.

— G ??_J_»—. Comestic
(=) Fgu.llnq.Gm.llam -
Notification: — [ — - |
indicates that the Bl s omentc
Interact Professional
user wants to be R

notified when calls
are parked for that

recipient.
Search field: enter criteria Retrieve button: click to answer
about a specified park call. any parked call.
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6.9.3 Reminder Period

If the parked call recipient does not retrieve the call within the time configured, the Verge IP phone and
Interact Softphone provide a notification to the user. See the Verge IP Phone Series User Guide to
configure the Reminder Period setting on the phone. Interact Softphone Reminder Periods are
configured by the Allworx Administrator on the Allworx System Administration web page.

6 alivorx

6.9.4 Call Route Settings

For Park to Extension only: After the timeout period expires, the call follows the next call handling step
defined per the extension setting:

+ User Extension: Defined in the current presence settings of the recipient Allworx User extension
configuration. Allworx users with permissions can adjust the Park To Extension timeout and call
handling using My Allworx Manager.

System Extension: Defined in the Day/Night mode settings of the recipient Allworx System
extension configuration is handled by the Allworx Server Administrator.

6.10 Queue Status

The Queue Status pane displays the Call Queue and ACD Queue information when the user is a
supervisor or agent of the queue, and/or has a Ring All PFK (Verge phone) or Programmable Function
Queue Appearance or ACD Appearance (Interact Softphone) assigned to the handset. Additionally, the
Queue Status pane provides a shortcut to the Allworx View application.

Hide Window
I 4—Icon

Queue [ Launch Alvo view 4T Shortcut to
Information ’ Sales - Narth America Fairness - Longest |dle Agents Logged Inz 2 Longest Wait Time : 00:00:00 Il A”WOI'X
View

Agent Status —p

Information

Chris Jones
Frank Lane
Olivia M King

on Call
Busy
Logged Out

Reason

On call
Meeting

Duration

nnnnnn
00:01:02

Active Queues.
Sales - North America

Sales - Europe

Linear Priority

Agents Logged In: 0

Longest Wait Time : 00:00:00

Hotline - North America

Fairness - Longest Idle

Agents Logged In: 4

Longest Wait Time : 00:00:00

4|
Calls in Queue: 0 I
:0 |

¥

To answer an ACD call without logging into the ACD queue:
Connect to the call with the longest wait time. Right-click the ACD queue name > Answer Call.
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To identify the Queue Line information:
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All information is available to the queue agent. For Ring-All queues only: the window displays all
information except Agents Logged In.

The Queue Line provides the following information:

Information Description
Queue Description* Name of the queue.
Queue Distribution Mode* Identifies the calls distribution method:
* Ring All * Linear + Sequential Round Robin  « Fairness - Longest
Priority Idle
Agents Logged In ]dentifies the nu;nber of logged i;’l agents in the queue.
Longest Wait Time* Period of time the oldest waiting call is in the queue.
Calls in Queue* Identifies the number of unanswered calls waiting in the queue.

To identify the Agent Status information:
Only queue supervisors can see this information. Click the arrow to the left of the queue description.

Field Description

Agent Displays the agents assigned to the queue.

State Identifies agent status.

Reason Identifies the agent busy state.

Duration Identifies the amount of time the agent in the current state except for the logged out
state.

Active Queues Identifies the queue when the agent is currently handling a call.

6.10.1 Accessing the View Application

Access detailed Allworx phone system data and usage reporting. Click Launch Allworx View to open
the View application in the default web browser window, and then manage the View application as
defined in the Allworx View Application User’s Guide. If the Launch Allworx View option is unavailable,
the Interact Professional user interface periodically checks for View availability.

6.10.2 Queue Alarms

Alarms are available that alert the users in the Supervisor role when the wait time for a call within the
queue and/or the queue depth have reached defined maximums. These maximums are defined by the
Allworx System Administrator using the Allworx System Administration web page to assign PFKs to
an Allworx desk phone or Programmable Functions to Interact Softphone.

When either alarm threshold has been reached, the listing for the queue in the Queue Status pane

flashes in either yellow or red, depending on the severity of the alarm. If enabled, an audible alarm also
sounds.
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L

| » ACD Faimess - Longest idle Agents Logged in: 0 Longest Wast Time::00:00 Calls in Queue: 0 |I
Ring All Ring All Agents Logged Inz - Longest Wait Time : 00:00 Calls in Cueue: 0 |
Queue 2 Ring Al Agents Logged In s - Longest Wast Time 3 00:00 Calls in Queve: 0 |

To end the alarm, right-click on the queue entry and select either Silence alarm or Dismiss alarm from
the pop-up menu.

Queue Status

B ACD Fairness - Lam -
: Silence alarm
Ring All Ring Al Dismiss alarm
Cliaig Bine All

A similar alarm can also be defined for when there are no agents logged in to a queue. Similarly, the
entry for the queue flashes yellow or red and an audible alarm sounds. For this alarm, right-click on the
queue and select Silence alarm, Dismiss alarm, or Answer Call from the pop-up menu.
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Interact Sync is a customizable plug-in that enables click-to-dial capabilities between Interact
Professional and Interact Softphone and installed versions of the Skype for Business 2015 or 2016,
and Microsoft Outlook 2010, 2013, and 2016 applications, as well as the Google Chrome and Mozilla
Firefox web browsers. Additionally, Interact Sync supports synchronization between Allworx Presence
and Skype for Business Availability, Microsoft Outlook meetings, and the Allworx handset. When
manually changing a presence or Availability status in one application, the other application
synchronizes to that status. To customize the Interact Sync feature, see “Configuring the Application
from the Options Menu” on page 39.

When manually selecting a Skype for Business Availability, or an Interact Professional user interface
Presence setting, the applications synchronize and display the following respective settings:

Interact Professional Presence Skype for Business Availability
In office Available

Busy Busy

(Unaffected) Do Not Disturb

Away Be Right Back

At Home Off Work

Away Appear Away

7.1 Set Interact Sync as the Default Dialing Application

While installing the Interact Sync application, the following occurs on the Windows operating system:

Windows 8

+ If there is already a default TEL protocol handler, Interact Sync does not register as the default TEL
protocol during installation. To register the Interact Sync plug-in as the Windows default dialing
application on the PC:

+ Click Start > Control Panel > Default Programs.
+ Click Set your default programs.
+ Locate and click Allworx Interact Sync > Choose defaults for this program.

+ Check the box next to TEL, and then click Save. The Windows operating system saves the
changes.

If there is not a default TEL protocol handler, the operating system registers the Interact Sync
application as the default TEL protocol handler during installation.

Windows 10
After installing the Interact Sync application, the Windows 10 operating system displays a pop-up
message asking the user to select the TEL protocol handler to use when performing a TEL function.
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To use the TEL protocol:

Perform one of the following:

+ Executing a TEL protocol from the Windows Run dialog box.
+ Click the PC Start icon.
+ Locate the search field, type RUN in the field, and hit enter. The RUN window opens.

+ Type tel: <phone number> in the field, and then click OK. The Allworx phone connected to
the Interact Professional application automatically dials the number.

=== Typethe name of a program, folder, document, or Internet
resource, and Windows wil open it for you.

Open: tel:+1-555-234-5678

Cancel || Browse... |

+ Double-click a Windows shortcut that points to a TEL protocol.
+ Locate the Windows shortcut and double-click.

« Locate the <type> Document tab. Verify the number is correct and click OK. The Allworx phone
connected to the Interact Professional application automatically dials the number.

sy Allworx Properties e

General Web Document  Securty Details  Previous Versions

ﬁ‘ Allworx

URL:

Shortcut key: |N0ne

isits: Unknown

Change Icon...

Cancel Apply

« Supports the TEL protocol if the web page supports TEL protocol.
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7.2  Click-to-dial with the Google Chrome or Mozilla Firefox
Web Browser

Easily click-to-dial a phone number on a Google Chrome or Mozilla Firefox web page using the Interact
Professional user interface (with an Allworx desk phone or Allworx Interact Softphone). Users can
navigate to a web page, click a phone number to dial, and automatically send a call from the Allworx
handset connected to the Interact application.

To select the number to dial:
Select one of the following options:

+ Click the enabled Allworx logo, and then select a detected number in the drop-down list. If Interact
Sync does not detect any phone numbers, the Allworx logo is disabled. Examples below are from
Mozilla Firefox web browser (Google Chrome browser displays the Allworx logo in the URL
Address bar).

W ot Prone Und = | op [T P

* 3 " +4 A T O QD a O
& Mout Visded @ Fogiiuge [l TestPai (@) Server LAN DEFALRT Q8 tper/ 17238201050 ] B4 ] B2

VolP F"hone Systems & Unified Communications 3\ Allworx Blog
Solutions .

B Press Releases @ videos

I

t 8 Fostop Bttt o L 1 G v 1725 110 [ e I 030 ) o 0

&ﬁﬂﬂﬂ-"Da

TAKE YOUR - S
SECURITY FURTHER

Phone number detected No phone number detected

+ Place the cursor over the phone number listed on the web page - the cursor changes from an
arrow to a hand. Click the number.

RECOGNITION

Off to a fast start in 2015

“The thrill isn't in the winning, its in the doing.™ Allworx is thrilled to be a communications
industry leader that introduces innovative products and services year after year. The awards are
"icing on the cake” 2015 is off to a great start with the Best Channel Vendaor award from Business
Solutions Magazine. And Allworx View and Allworx Interact have been honored with awards for best
products for 2015 by Internet Telephony Magazine. (“guote from Hall of Fame Coach Chuck Noll).
View Awards »

Company Community

Instaliation Overview Awards | Press Releases Facebook | Twitter |

Events

1-866-ALLWORX

ContactUs | Partners | Privacy | Sitemap | ©2015 Allworx Corp, a Windstream company. ALL rights reserved.
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+ Highlight and right-click the phone number on the web page.

File Edit View History Bookmarks Tools Help _ O b

Al VolP Phone Systems | Unif.. X 4

€« www.allworx.com c Search 4+ A W B 4 @& @

[8) Most Visited @ FogBugz EH TestRail (@Y Server LAN DEFAULT (@ https://172.16.211.153/... ] B4-42x [B] B4-24x (&Y Connect 731 »

Products

Company Community
Allworx Connect Series Award cepe

Facebook | Twitter

Form Awards
Events

EBlog

1-866-ALLWORX]

Copy
Select All

ContactUs | Partmers | Privacy | Sitemap | ©2015 Allwo

Share Selection

View Selection Source
Inspect Element (Q)
@ Dial "1-866-ALLWORX"

To disable Interact Sync within the Mozilla Firefox web browser:

Navigate to Open menu > Add-ons Manager > Extensions > Allworx Interact Sync for Firefox >
Disable.

To disable Interact Sync within the Google Chrome web browser:

Navigate to Open menu > Settings > Extensions > Allworx Interact Sync for Chrome and then uncheck
the Enable check box.

7.3 Click-to-dial with Microsoft Outlook

Click-to-dial a Microsoft Outlook 2010, 2013, or 2016 contact with the Interact Professional
application and a connected Allworx desk phone.

Interact Professional users can right-click any Outlook contact and then Allworx dial to see the
available phone number information (except FAX numbers). After selecting a phone number, the
Interact Professional application automatically sends a call from the connected Allworx handset to the
Outlook contact.

The Allworx dial menu is available in the following Outlook screens:
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FLE HOME SEND / RECEVE FOLDER L3l

Lou Robinson

David Smith

Christina Vandyne

Option 1

1. Right click the contact.

2. Click Allworx dial...

3. Click the contact phone number to dial.

Option 2

1. Click the ellipsis for more options.

2. Click Allworx dial...

3. Click the contact phone number to dial.

+  Email > To field
1T H ® : Untitled - Message (HTML)

MESSAGE |INSERT OPTIONS FORMAT TEXT REVIEW

Christina Vandyne 1
Paste . t Attach Signature
Item = - & Low Importance

iy By ™ Fallow Up =
z A
! High Impartance

Christina Yandyne (CVag) = '
% Cuf

1. Right click the email addressee.
2. Click Allworx dial...
3. Click the contact phone number to dial.

7.4  Presence Synchronization with Microsoft Outlook

Easily synchronize Allworx Presence with Outlook calendar appointments.

When creating or modifying an Outlook appointment, the Set Default Presence setting in the Outlook
tool bar enables selecting an Allworx Presence setting for an appointment. The Allworx Presence
status automatically updates through Interact Professional for the duration of the appointment, and
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then restores to the original value once the appointment is finished. The Allworx Presence changes to
the pre-appointment state after exiting the Interact Professional application.

MEETING INSERT FORMAT TEXT REVIEW
T ) v
x @ [3 Calendar D E‘ % W[E‘ 'E! 5“'@} EE: 22 show s |l Busy M O & Prate

! High Importance

Delete Copy to My L:.‘,Forward . Appointment Scheduling Skype Meeting Cancel Address Check Pe sponse| Use . Recurrence Time

Reminder: |13 minutes

Calendar Meeting Notes Invitation Book MNames Options=|  default = Zones ¥ Lowlmportance
Actions Show Skype Mee... Meeting N... Attendees Allwogt.. Options [F] Tags Zoom ~
o\fou haven't sent this meeting invitation yet.
From ~ | David Quil Unmaodified
cons Tow., Allen John; Anderson Bianca; Kennedy Chris; Allworx - East Coast z Show As based
Subject Weekly Sales Meeting )
In Office
Lacation Sales Conference Room -
— On Vacation
Start time Thu 1/28/2016 E 3:00 PM - All day event
Endtime | Thu1/28/2016 [E| 400 PM - At Home

On Business Trip
Use Default: displays a drop-down
list to select which Allworx Presence
Away setting to use while the meeting or
Busy appointment is in progress.

At A Meeting

MEETING INSERT FORMAT TEXT REVIEW
x @ [3 Calendar D E' % ﬁ R B 5:@) a z zShDWA W sy B O ‘:;}:I Private

) . - ! High Importance
Delete Copy to My E‘ Forward ~ ‘ppointment Scheduling Skype Meeting Cancel Address Check Response Reminder: |15 minutes - Recurrence Time

Calendar Meeting MNotes Invitation Book MNames Options = default' Zones ¥ LowImportance
Actions Show Skype Mee... Meeting M... Attendees Options IF] Tags Zoom = A

OYou haven't sent this meeting invitation yet.

From - | David Quil

To... Allen John; Anderson Bianca; Kennedy Chris; Alwarx - East Coast
Send #y Appointments and Allworx Presence v2.3 X
Subject Weekly Sales Meeting
[l Synchronize my Allworx Presence with my Outleck calendar
Location Sales Conference Room -

. ar Select a Presence setting that will be applied to all appointments that
Starttime | Thu 1/28/2016 fE| 300 PM - Tz the defoul: Presence.

Endtime  |Thu1/28/2016 FE| | 400 Pm Defauit Presence: - TSI N -

4

Do ot modify my Presence for appointments with a “Show As” value of

Allworx....check the box to enable the
synchronization. Use the drop-down

list to select the default presence, and
then click OK.

[l Free
[ Tenataive

When the Allworx Presence setting is not set for an appointment or is explicitly set to use the default
setting, the user’s Allworx Presence status updates to the default value for the duration of the
appointment. Users can configure the Allworx Presence value in the Interact Sync options screen in
Interact Professional or by selecting the default Presence in Outlook.

Users can also modify an Allworx Presence based on the “Show As” value for the given appointment.
The Show As value of an appointment maps to an Allworx Presence according to the following:

Outlook “Show As” Value * Free Working Busy Out of Office
+ Tentative Elsewhere
Allworx Presence Value Does not change the user’s On Business Trip At A Meeting  Away
Presence
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Chapter 8 Troubleshooting

Condition Description Solution

Installation

Interact application McAfee anti-virus is interfering User must do a complete removal of McAfee anti-virus, using
provides “Could not with the installation of the the MCPR.exe tool.

access VBScript Allworx Interact application. 1. Navigate to Start > Control Panel > Programs and Features.

runtime for custom
action” error
message.

2. Locate the McAfee software, and click the Uninstall button
at the top of the list.

3. Download the MCPR.exe tool from http://
download.macafee.com/products/licensed/
cust _support patches/MCPR.exe.

4. Run the tool.

5. Download Microsoft Fixit 50842.msi from http://
go.microsoft.com/?linkid=9804433.

6. Run the tool.
7. Reboot the computer.
8. Install the Allworx Interact Professional software.

Note: The Allworx Interact Professional application requires an
additional un-install and re-install.

Warning message In Windows, users can install
during the Interact Interact for multiple user
application uninstall accounts.

process.

Click Continue to uninstall the Allworx Interact application. This
does not affect other installations of the Interact application.

The current Interact Control Panel > Programs and

application version Features > Uninstall or change
level does not match  a program page reports the
the Control Panel > application installed version,
Programs and not the upgraded version.

Features > Uninstall or
Change a program
version level after
upgrading the
application.

The Windows un-installer works without regard to version level
reported in the Control Panel > Programs and Features > Install
or Change a program page.

866.ALLWORX (866.255.9679) or 585.421.3850
www.allworx.com
Version: A Revised: October 21, 2020

Page 85


http://download.macafee.com/products/licensed/cust_support_patches/MCPR.exe
http://download.macafee.com/products/licensed/cust_support_patches/MCPR.exe
http://download.macafee.com/products/licensed/cust_support_patches/MCPR.exe
http://go.microsoft.com/?linkid=9804433

Allworx Interact Release 5.1 User Guide

eallv@q

Condition

Description

Solution

During install the
following message
displays:

You do not have
sufficient privileges to
complete this
installation for all
users of the machine.

Log on as the
administrator and
retry this installation.

Insufficient PC privileges to

install Interact Sync.

Interact continues to install. The Interact Sync application and
features are unavailable.

| believe the following link needs updating...

User must run Interact Sync installer as administrator. Interact
Sync installer is located at:
%localappdata%\Allworx\Interact\<current

Login

Receiving a Windows
Security Alert dialog
window when clicking
the Find Server IP
button.

Windows users with limited
privileges are clicking the Find
Server IP button, and the
firewall exception for the
application may not exist.

Click OK to close the Windows Security Alert dialog window.

To add the Allworx Server IP:

+ Ask the Allworx administrator the IP address of the server,
and enter the IP address manually.

+ Ask the Allworx administrator to add a firewall exception on
the workstation for the Interact application.

The Interact
application detects an
upgrade is available,
but user sees an error
message when
attempting to
upgrade.

The Interact application
detected an upgrade.

Exit the application by clicking the icon in the Windows System
Tray, and click Exit. Restart the application.

The Interact
application feature
does not work as
described.

The Interact application

features are missing or don't

work properly.

Verify that the Interact application is the latest version.

Password failure

The Interact application does
not accept the newly changed

password.

The new password or PIN does not meet the Allworx System
Software requirements. Contact the Allworx administrator for
the password/PIN requirements.

Logged in, application
opens, but it is not
available on the

The Interact application was
minimized to the Windows
System Tray prior to the last

To open the Interact Professional user interface to full screen:

1. Locate the Windows System Tray (lower right corner of the
screen - typical).

screen. application exit. 2. Click the Allworx icon (red circle with white lowercase “a”). A
drop-down menu displays.
3. Click Open. The user interface displays full screen.
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Condition Description Solution
Messages
Message displays: The Interact application has Verify the following connections:
Communication with  lost contact with the phone « Phone
phone has been lost.  and is attempting to - Computer
Attempting to reconnect. -
+ Network activity
reconnect.
Verify phone is not rebooting.
If the Allworx administrator rebooted the phones, restart the
Interact or Interact Professional application.
Message displays: The Interact application Verify the following connections:
Reconnecting with the connection to phone was lost, . Phone
phone. and is actively attempting to - Computer
reconnect. + Network activity
Verify phone is not rebooting.
Message displays: While recording, no incoming  Verify the firewall on the PC enables the Interact application as
Not receiving audio. data was received. May an exception. Contact the system administrator.

Contact your system indicate a firewall issue.
administrator.

Message displays: The call recording storage Move or delete older call recording files or designate a new
The recording directory has no more storage location to store call recording files. See “Begin talking using
directory file systemis space available. the designated Allworx handset, and then click End Call when
full. Recording has finished.” on page 38 for more information.

been stopped.

Manage Calls

Cannot place a callon Cannot access an outside Dial the outside line access digit set in your dial plan - usually 9
an outside line. phone line. or 78+PIN code.

If this does not work, verify with the Allworx administrator that
the outside line access information based on the Dial Plan
External Dialing Rules.

Current active call Handset not configured to Configure the Allworx handset. On the handset, navigate to
drops when selecting  automatically place the CONFIG > Preferences > Auto On Hold. Select Enabled and exit
Dial or Intercom current call on hold so that the handset configuration menu.
features. user may place another call.
The Intercom Call The 9202E model Allworx The 9202E model Allworx phone does not support Intercom
option does not work. phone does not support calls.

Intercom Calls.
Selected Interact Interact user selected an The Allworx Administrator must add the local area code into the
contact does not dial  Interact contact to dial witha  Allworx server dial plan, but the Allworx server strips the “9 + 1”
correctly. local number that requires from the entered phone number.

dialing an area code. The Allworx Administrator must configure the Allworx server so

that the send digits as dialed on the outside line is disabled.
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Condition

Description

Solution

An error message
displayed when the
recording drive is
unavailable.

While recording an Interact
call, the drive specified to
store the recording file
becomes unavailable.

Do one of the following:

* Restore drive connection.

+ Select a new location to store the recording file.
+ Cancel the recording. The file will be lost.

Windows

The undocked Parked
Calls window is
empty.

The undocked Parked Calls
window does not populate
after selecting More > Park or
when doing a drag and drop.

Verify with the Windows Administrator that the Interact
application is on the same network as the handset and network
routing is consistent.

Not all the panes
display in the Interact
Professional user
interface.

The Visible Windows setting
was changed.

The user may not have server
permissions to display certain
windows.

Navigate to Settings > Visible Windows and select the windows
to display.

Verify the correct permissions to view active system calls. Also,
the outside lines window does not display if the her does not
have any outside lines defined for the handset.

Cannot find the
personal contacts in
the Contact pane.

Outlook Interact contacts do
not display in the Interact
Professional user interface
Contact pane.

The Interact Professional user interface requires the Outlook
2010 application to be open prior to launching the application.

1. Close the application.
2. Launch the Outlook 2010 application.
3. Restart the Interact Professional application.

The Outlook contacts are now available within the Interact
Professional user interface.

Agentisinan
unknown state.

The agent logged out of the
Interact application while the
application was in a hibernate,
sleep, or screen lock state.

Restart the Interact application.

The Agent option for
Interact Softphone is
not included in the

Visible Windows list.

The Agent <user name> pane
is not visible and is not able to
be selected as an option in the
Visible Windows drop-down
list.

Contact your system administrator to verify that the user has an
ACD Programmable Function defined for the Interact Softphone
handset.

Interact Sync

Interact Sync is not
working.

The Interact Professional
application is not
synchronizing with Skype for
Business application.

The Interact Sync application requires the Skype for Business
2015 or 2016 application to be running. Interact Sync does not
work with earlier versions of Skype for Business.
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Condition Description Solution
The Interact The synchronization between Do the following:
Professional user the Skype for Business « Check the Skype for Business client is updating properly.
interface presence application and the Interact « Verify the Interact Sync feature key and application are
setting is not Professional application is not installed.
;}rlggz:@mzmg updating properly. + Check the settings in Settings > Options > Interact Sync.
' + Shutdown Skype for Business and Interact Professional, and
then restart in the following order:
+ Skype for Business
* Interact Professional
The Interact The Skype for Business Do the following:
Professional user application does not - Schedule meetings in advance.
interface Presence synchronize with the Outlook

Wi | + Check the Skype for Business client is updating properly.
does not change per  calendar availability, which

the Outlook calendar.  synchronizes with the Interact
Professional user interface
Presence setting.

The Allworx Presence  The Outlook calendar is not Check the following settings available at Settings > Options >
is not changing with syncing the Allworx Presence. Interact Sync and verify:

the Outlook + The Presence Synchronizations options check box is enabled
appointments. (checked).

+ The Override options are not enabled (unchecked) - e.g., On
Vacation, On Business Trip, or At Home.

+ The Appointments and Allworx Presence > Default Presence
for calendar appointments: is set to the “Show As” based
option.

+ The Appointments and Allworx Presence > Do not modify my
presence for appointments with a “Show as” value of:
overrides are not enabled (unchecked) - Free or Tentative.

The Outlook welcome User does not have an Outlook Interact Professional user interface automatically retrieves
screen displays. profile and does not expectto contacts from Microsoft Outlook, regardless if there has never
see this screen. been an Outlook profile created.

Miscellaneous

The Interact Only running applications with 1. Open the Task Manager and click the Processes tab.
application doesnot i .o window showing 2. Locate InteractStartup.exe and right click on it.

respond. When display in the Task Manager 3. Click End Process to close the application.
starting Task

Manager, the Applications list. 4. Re-launch the Interact application.
application does not
display in the
Applications tab.
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Condition

Description

Solution

The font does not look
crisp.

Windows XP users may
experience bit mapped fonts

within the Interact Application.

1. Navigate to the computer desktop and right-click on the
desktop. Select Properties from the drop-down list. The
Display Properties control panel box displays.

2. Click the Appearance tab, and then the Effects button.

3. Click the check box “Use the following method to smooth
edges of screen fonts”.

4. Click the drop-down arrow and select Cleartype.

5. Click OK, and then click Apply, and then click OK to save the
changes.

The recording
directory no longer
exists. Please check
the file system.

The call recording storage
directory is not available.

Verify the directory is still available or designate another
location to store the call recording files. See “Begin talking
using the designated Allworx handset, and then click End Call
when finished.” on page 38 for more information.

Cannot find the
Launch Allworx View
button.

The Launch Allworx View
option is not available in the
Queue status window, the
Device Status Options
drop-down list, or the System
Tray options.

The Launch Allworx View option is unavailable until the Allworx
administrator installs the View CDR feature key and establishes
a connection between the Allworx server and the View server.

Interact is unable to validate the default View application link.

Unable to update the
contact image.

The option to upload a
directory contact image is
unavailable.

The Allworx Server Administrator has disabled the ability to
upload a directory contact image. Contact the Allworx Server
Administrator to enable this option.

Directory contact
image is gone.

Added a directory contact
image, but it is no longer
available

The Allworx Server Administrator has deleted the contact
image. Replace with a new image.

An alert icon (0)
appears to the right of
the Interact Softphone
Presence drop-down
list.

This icon displays on the user
interface as an error
message, such as BLF lost,
Interact lost connection,
Running out of recording
space, etc.

Detailed information about the error condition can be seen by
hovering the mouse cursor over the alert icon.
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The Interact Professional user interface provides a wide range of options for managing calls. The
following table is useful as a reference for locating varying instructions for some of the most common
call management tasks discussed throughout this document.

Call Management Task Link to Instructions

Answering a call + “To answer a call from the pop-up dialog box:” on page 25“To
answer another user’s call from the expanded user interface
Contacts pane:” on page 26

+ “To pick-up another user’s call from the Contacts pane:” on
page 63

Placing a call + “To place a call using an Allworx desk phone:” on page 22

+ “To place a call using the expanded user interface Call History or
Contacts pane:” on page 22

+ “To place a call using the expanded user interface Dialpad pane:”
on page 23

+ “To answer a call from the pop-up dialog box:"” on page 25

* “To place a call:" on page 63

“Placing a Call On Hold” on page 27

Placing a call on hold

* “To place a call on hold:” on page 66

Ending a call + “Supervising a Call” on page 28
Transferring a call + “To transfer a call using the expanded Interact user interface” on
page 66
Parking a call + “To Park a call when using Allworx System Software 8.5 or higher:”
on page 72
* “To park a call when using Allworx System Software 8.4 or lower:"
on page 72
+ “To retrieve a parked call:” on page 73
Muting a call + "Muting a Call” on page 34
Supervising calls “Supervising a Call” on page 28
Placing an intercom call + “Placing an Intercom Call” on page 29
Creating a conference call “To create a conference call:" on page 68

“To end a conference call using the Interact Professional user
interface:” on page 68

Recording a call + “To record an active call:" on page 37
Continued
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Call Management Task Link to Instructions
Managing Voicemail messages “Messages” on page 70
Managing contact information and images “Contacts” on page 55

+ “To change the user presence” on page 38

Managing user presence settings

* “To answer an ACD call without logging into the ACD queue:” on
page 76
+ “To identify the Queue Line information:” on page 77

Handling queue calls
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